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Chapter 1 

Introduction 

The design of concrete frames is seamlessly integrated within the program. Ini-
tiation of the design process, along with control of various design parameters, 
is accomplished using the Design menu.  

It should be noted that two design processes are available in CSiBridge:  su-
perstructure design (on the Design/Rating tab) and design of the individual 
elements comprising the structure (the Advanced > Frame Design com-
mands). This manual addresses the second design process. 

Automated design at the object level is available for any one of a number of 
user-selected design codes, as long as the structures have first been modeled 
and analyzed by the program. Model and analysis data, such as material prop-
erties and member forces, are recovered directly from the model database, and 
no additional user input is required if the design defaults are acceptable.  

The design is based on a set of user-specified loading combinations. However, 
the program provides default load combinations for each design code sup-
ported in the program. If the default load combinations are acceptable, no defi-
nition of additional load combinations is required.  

In the design of columns, the program calculates the required longitudinal and 
shear reinforcement. However, the user may specify the longitudinal steel, in 
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which case a column capacity ratio is reported. The column capacity ratio gives 
an indication of the stress condition with respect to the capacity of the column.  

The biaxial column capacity check is based on the generation of consistent 
three-dimensional interaction surfaces. It does not use any empirical formula-
tions that extrapolate uniaxial interaction curves to approximate biaxial action.  

Interaction surfaces are generated for user-specified column reinforcing con-
figurations. The column configurations may be rectangular, square or circular, 
with similar reinforcing patterns. The calculation of moment magnification 
factors, unsupported lengths and strength reduction factors is automated in the 
algorithm.  

Every beam member is designed for flexure and shear at output stations along 
the beam span.  

All beam-column joints are investigated for existing shear conditions.  

For Ductile and Moderately Ductile moment resisting frames, the shear design 
of the columns, beams and joints is based on the probable moment capacities 
of the members. Also, the program will produce ratios of the beam moment 
capacities with respect to the column moment capacities, to investigate weak 
beam/strong column aspects, including the effects of axial force.  

Output data can be presented graphically on the model, in tables for both input 
and output data, or on the calculation sheet prepared for each member. For 
each presentation method, the output is in a format that allows the engineer to 
quickly study the stress conditions that exist in the structure and, in the event 
the member reinforcing is not adequate, aids the engineer in taking appropriate 
remedial measures, including altering the design member without rerunning the 
entire analysis.  

1.1 Organization 
This manual is designed to help you quickly become productive with the con-
crete frame design options of CSA A23.3-04. Chapter 2 provides detailed de-
scriptions of the Deign Prerequisites used for CSA A23.3-04. Chapter 3 
provides detailed descriptions of the code-specific process used for CSA 
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A23.3-04. Chapter 4 documents the design output produced by program. The 
appendices provide details on certain topics referenced in this manual.  

1.2 Recommended Reading/Practice 
It is strongly recommended that you read this manual and review any applica-
ble “Watch & Learn” Series™ tutorials, which are found on our web site, 
http://www.csiberkeley.com, before attempting to design a concrete frame. 
Additional information can be found in the on-line Help facility available from 
within the program’s main menu. 
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Chapter 2 

Design Prerequisites   

This chapter provides an overview of the basic assumptions, design precondi-
tions, and some of the design parameters that affect the design of concrete 
frames. 

In writing this manual it has been assumed that the user has an engineering 
background in the general area of structural reinforced concrete design and fa-
miliarity with CSA A23.3-04 codes.  

2.1 Design Load Combinations 
The design load combinations are used for determining the various combina-
tions of the load cases for which the structure needs to be designed/checked. 
The load combination factors to be used vary with the selected design code. 
The load combination factors are applied to the forces and moments obtained 
from the associated load cases and are then summed to obtain the factored de-
sign forces and moments for the load combination. 

For multi-valued load combinations involving response spectrum, time history, 
moving loads and multi-valued combinations (of type enveloping, square-root 
of the sum of the squares or absolute) where any correspondence between in-
teracting quantities is lost, the program automatically produces multiple sub 
combinations using maxima/minima permutations of interacting quantities. 
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Separate combinations with negative factors for response spectrum cases are 
not required because the program automatically takes the minima to be the 
negative of the maxima for response spectrum cases and the above described 
permutations generate the required sub combinations. 

When a design combination involves only a single multi-valued case of time 
history or moving load, further options are available. The program has an op-
tion to request that time history combinations produce sub combinations for 
each time step of the time history. Also an option is available to request that 
moving load combinations produce sub combinations using maxima and min-
ima of each design quantity but with corresponding values of interacting quan-
tities.  

For normal loading conditions involving static dead load, live load, wind load, 
and earthquake load, or dynamic response spectrum earthquake load, the pro-
gram has built-in default loading combinations for each design code. These are 
based on the code recommendations and are documented for each code in the 
corresponding manuals. 

For other loading conditions involving moving load, time history, pattern live 
loads, separate consideration of roof live load, snow load, and so on, the user 
must define design loading combinations either in lieu of or in addition to the 
default design loading combinations. 

The default load combinations assume all load cases declared as dead load to 
be additive. Similarly, all cases declared as live load are assumed additive. 
However, each load case declared as wind or earthquake, or response spectrum 
cases, is assumed to be non additive with each other and produces multiple lat-
eral load combinations. Also wind and static earthquake cases produce separate 
loading combinations with the sense (positive or negative) reversed. If these 
conditions are not correct, the user must provide the appropriate design com-
binations.   

The default load combinations are included in design if the user requests them 
to be included or if no other user-defined combination is available for concrete 
design. If any default combination is included in design, all default combina-
tions will automatically be updated by the program any time the design code is 
changed or if static or response spectrum load cases are modified.  
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Live load reduction factors can be applied to the member forces of the live load 
case on an element-by-element basis to reduce the contribution of the live load 
to the factored loading. 

The user is cautioned that if moving load or time history results are not re-
quested to be recovered in the analysis for some or all of the frame members, 
the effects of those loads will be assumed to be zero in any combination that 
includes them. 

2.2 Design and Check Stations 
For each load combination, each element is designed or checked at a number of 
locations along the length of the element. The locations are based on equally 
spaced segments along the clear length of the element. The number of seg-
ments in an element is requested by the user before the analysis is made. The 
user can refine the design along the length of an element by requesting more 
segments. 

When using the CSA A23.3-04 design code, requirements for joint design at 
the beam to column connections are evaluated at the top most station of each 
column. The program also performs a joint shear analysis at the same station to 
determine if special considerations are required in any of the joint panel zones. 
The ratio of the beam flexural capacities with respect to the column flexural 
capacities considering axial force effect associated with the 
weak-beam/strong-column aspect of any beam/column intersection are re-
ported. 

2.3 Identifying Beams and Columns 
In the program, all beams and columns are represented as frame elements. But 
design of beams and columns requires separate treatment. Identification for a 
concrete element is accomplished by specifying the frame section assigned to 
the element to be of type beam or column. If any brace element exists in the 
frame, the brace element also would be identified as a beam or a column ele-
ment, depending on the section assigned to the brace element. 
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2.4 Design of Beams 
In the design of concrete beams, in general, the program calculates and reports 
the required areas of steel for flexure and shear based on the beam moments, 
shears, load combination factors, and other criteria, which are described in de-
tail in the code-specific chapters. The reinforcement requirements are calcu-
lated at a user-defined number of stations along the beam span. 

All the beams are only designed for major direction flexure and shear. Effects 
due to any axial forces, torsion and minor direction bending that may exist in 
the beams must be investigated independently by the user. 

In designing the flexural reinforcement for the major moment at a particular 
section of a particular beam, the steps involve the determination of the maxi-
mum factored moments and the determination of the reinforcing steel. The 
beam section is designed for the maximum positive and maximum negative 
factored moment envelopes obtained from all of the load combinations. Nega-
tive beam moments produce top steel. In such cases, the beam is always de-
signed as a Rectangular section. Positive beam moments produce bottom steel. 
In such cases, the beam may be designed as a Rectangular beam or a T beam. 
For the design of flexural reinforcement, the beam is first designed as a singly 
reinforced beam. If the beam section is not adequate, the required compression 
reinforcement is calculated. 

In designing the shear reinforcement for a particular beam for a particular set 
of loading combinations at a particular station due to the beam major shear, the 
steps involve the determination of the factored shear force, the determination 
of the shear force that can be resisted by concrete, and the determination of the 
reinforcement steel required to carry the balance. 

Special considerations for seismic design are incorporated into the program for 
CSA A23.3-04. 

2.5 Design of Columns 
In the design of the columns, the program calculates the required longitudinal 
steel, or if the longitudinal steel is specified, the column stress condition is re-
ported in terms of a column capacity ratio, which is a factor that gives an indi-
cation of the stress condition of the column with respect to the capacity of the 
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column. The design procedure for the reinforced concrete columns of the struc-
ture involves the following steps: 

 Generate axial force-biaxial moment interaction surfaces for all of the dif-
ferent concrete section types of the model.  

 Check the capacity of each column for the factored axial force and bending 
moments obtained from each loading combination at each end of the col-
umn. This step is also used to calculate the required reinforcement (if none 
was specified) that will produce a capacity ratio of 1.0. 

The generation of the interaction surface is based on the assumed strain and 
stress distributions and some other simplifying assumptions. These stress and 
strain distributions and the assumptions are documented in Chapter 3. 

The shear reinforcement design procedure for columns is very similar to that 
for beams, except that the effect of the axial force on the concrete shear capac-
ity must be considered.  

For certain special seismic cases, the design of columns for shear is based on 
the capacity shear. The capacity shear force in a particular direction is calcu-
lated from the moment capacities of the column associated with the factored 
axial force acting on the column. For each load combination, the factored axial 
load is calculated, using the load cases and the corresponding load combination 
factors. Then, the moment capacity of the column in a particular direction un-
der the influence of the axial force is calculated, using the uniaxial interaction 
diagram in the corresponding direction, as documented in Chapter 3.  

2.6 Design of Joints   
To ensure that the beam-column joint of special moment resisting frames pos-
sesses adequate shear strength, the program performs a rational analysis of the 
beam-column panel zone to determine the shear forces that are generated in the 
joint. The program then checks this against design shear strength. 

Only joints having a column below the joint are designed. The material proper-
ties of the joint are assumed to be the same as those of the column below the 
joint. The joint analysis is done in the major and the minor directions of the 
column. The joint design procedure involves the following steps: 
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 Determine the panel zone design shear force,  

 Determine the effective area of the joint, and 

 Check panel zone shear stress. 

 
The joint design details are documented in Chapter 3. 

2.7 P-Delta Effects 
The program design process requires that the analysis results include P-delta 
effects. The P-delta effects are considered differently for “braced” or 
“non-sway” and “unbraced” or “sway” components of moments in columns or 
frames. For the braced moments in columns, the effect of P-delta is limited to 
“individual member stability.” For unbraced components, “lateral drift effects” 
should be considered in addition to individual member stability effect. The 
program assumes that “braced” or “nonsway” moments are contributed from 
the “dead” or “live” loads. Whereas, “unbraced” or “sway” moments are con-
tributed from all other types of loads. 

For the individual member stability effects, the moments are magnified with 
moment magnification factors, as documented in Chapter 3 of this manual.  

For lateral drift effects, the program assumes that the P-delta analysis is per-
formed and that the amplification is already included in the results. The mo-
ments and forces obtained from P-delta analysis are further amplified for 
individual column stability effect if required by the governing code, as in the 
CSA A23.3-04 codes. 

Users should be aware that the default analysis option in the program is turned 
OFF for P-delta effect. The user can turn the P-delta analysis ON and set the 
maximum number of iterations for the analysis. The default number of iteration 
for P-delta analysis is 1. Further details on P-delta analysis are provided in 
Appendix A of this design manual. 

2.8 Element Unsupported Lengths 
To account for column slenderness effects, the column unsupported lengths are 
required. The two unsupported lengths are l33 and l22. These are the lengths be-
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tween support points of the element in the corresponding directions. The length 
l33 corresponds to instability about the 3-3 axis (major axis), and l22 corresponds 
to instability about the 2-2 axis (minor axis).  

Normally, the unsupported element length is equal to the length of the element, 
i.e., the distance between END-I and END-J of the element. The program, 
however, allows users to assign several elements to be treated as a single 
member for design. This can be done differently for major and minor bending 
as documented in Appendix B of this design manual.  

The user has options to specify the unsupported lengths of the elements on an 
element-by-element basis. 

2.9 Choice of Input Units 
English as well as SI and MKS metric units can be used for input. But the 
codes are based on a specific system of units. All equations and descriptions 
presented in the subsequent chapters correspond to that specific system of units 
unless otherwise noted. For example, the CSA A23.3-04 code is published in 
Millimeter-Newton-Second units. By default, all equations and descriptions 
presented in the chapter “Design for CSA A23.3-04” correspond to Millime-
ter-Newton-Second units. However, any system of units can be used to define 
and design the structure in the program. 

It should be noted that two design processes are available in CSiBridge:  su-
perstructure design (on the Design/Rating tab) and design of the individual 
elements comprising the structure (the Advanced > Frame Design com-
mands). This manual addresses the second design process. 
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Chapter 3 

Design Process 

This chapter provides a detailed description of the code-specific algorithms the 
program uses to design concrete frames when the Canadian code 
CSAA23.3-04 (CSA 2004) is selected. For simplicity, all equations and de-
scriptions presented in this chapter correspond to Newton-Millimeter-Second 
units unless otherwise noted. 

The program provides options to design or check Conventional, Moderately 
Ductile (moderate seismic risk areas), and Ductile (high seismic risk areas) 
moment resisting frames as required for seismic design. The details of the de-
sign criteria used for the different framing systems are described in this chap-
ter. 

3.1 Notation 
The various notations used in this chapter are described herein:  

Acv Area of concrete used to determine shear stress, sq-mm 

Acore Area of concrete core, sq-mm 

Ag Gross area of concrete, sq-mm 

As Area of tension reinforcement, sq-mm 
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As Area of compression reinforcement, sq-mm 

As(required) Area of steel required for tension reinforcement, sq-mm 

Ast  Total area of column longitudinal reinforcement, sq-mm 

Av Area of shear reinforcement, sq-mm 

a Depth of compression block, mm 

ab Depth of compression block at balanced condition, mm 

b Width of member, mm 

bf Effective width of flange (T beam section), mm 

bw  Width of web (T beam section), mm 

Cm  Coefficient, dependent upon column curvature, used to calculate 
moment magnification factor 

c  Depth to neutral axis, mm 

cb  Depth to neutral axis at balanced conditions, mm 

d Distance from compression face to tension reinforcement, mm 

d Concrete cover to center of reinforcing, mm 

ds Thickness of slab (T beam section), mm 

Ec Modulus of elasticity of concrete, MPa 

Es Modulus of elasticity of reinforcement, assumed as 200,000 MPa

fc Specified compressive strength of concrete, MPa 

fy Specified yield strength of flexural reinforcement, MPa 

fyh Specified yield strength of shear reinforcement, MPa 

h Dimension of beam or column, mm 

Ig Moment of inertia of gross concrete section about centroidal axis, 
neglecting  reinforcement, mm4 

Ist Moment of inertia of reinforcement about centroidal axis of 
member cross-section, mm4 

k Effective length factor 
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L Clear unsupported length, mm  

M1 Smaller factored end moment in a column, N-mm 

M2 Larger factored end moment in a column, N-mm 

Mc Factored moment to be used in design, N-mm 

Mns Non-sway component of factored end moment, N-mm 

Ms Sway component of factored end moment, N-mm 

Mf Factored moment at section, N-mm 

Mfx Factored moment at section about X-axis, N-mm 

Mfy Factored moment at section about Y-axis, N-mm 

Nf  Factored axial load at section (tension positive), N 

Pb  Axial load capacity at balanced strain conditions, N 

Pc Critical buckling strength of column, N 

Pr,max Maximum axial load strength allowed, N 

Po Axial load capacity at zero eccentricity, N 

Pf Factored axial load at section (compression positive), N 

Vc  Shear resisted by concrete, N 

VD+L  Shear force from span loading, N 

Vp  Shear force computed from probable moment capacity, N 

Vf  Factored shear force at a section, N 

Vs  Shear force at a section resisted by steel, N 

α Reinforcing steel overstrength factor 

β  Factor accounting for shear resistance of cracked concrete  

θ Angle of inclination of diagonal compressive stresses with the 
longitudinal axis of beam or column  

β1  Factor for obtaining depth of compression block in concrete 

α1 Factor for obtaining average compressive stress in concrete block
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βd  Absolute value of the ratio of the maximum factored axial dead 
load moment to the maximum factored total load moment 

δb Moment magnification factor for non-sway moments 

δs  Moment magnification factor for sway moments 

εc  Strain in concrete 

εs Strain in reinforcing steel 

φc  Strength reduction factor for concrete 

φs  Strength reduction factor for steel 

φm  Strength reduction factor for member 

λ Shear strength factor 

3.2 Design Load Combinations 
The design load combinations are the various combinations of the prescribed 
load cases for which the structure is to be checked. The program creates a 
number of default design load combinations for a concrete frame design. Users 
can add their own design load combinations as well as modify or delete the 
program default design load combinations. An unlimited number of design 
load combinations can be specified.  

To define a design load combination, simply specify one or more load cases, 
each with its own scale factor. The scale factors are applied to the forces and 
moments from the load cases to form the factored design forces and moments 
for each design load combination. There is one exception to the preceding. For 
spectral analysis modal combinations, any correspondence between the signs 
of the moments and axial loads is lost. The program uses eight design load 
combinations for each such loading combination specified, reversing the sign 
of axial loads and moments in major and minor directions.  

As an example, if a structure is subjected to dead load, DL, and live load, LL, 
only, the CSA A23.3-04 design check may need only one design load combi-
nation, namely, 1.25 DL +1.5 LL. However, if the structure is subjected to 
wind, earthquake or other loads, numerous additional design load combinations 
may be required.  
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The program allows live load reduction factors to be applied to the member 
forces of the reducible live load case on a member-by-member basis to reduce 
the contribution of the live load to the factored responses.  

The design load combinations are the various combinations of the prescribed 
load cases for which the structure is to be checked. For this code, if a structure 
is subjected to dead load (DL), live load (LL), wind (WL), and earthquake 
(EL) loads, and considering that wind and earthquake forces are reversible, the 
following load combinations should be considered (CSA 4.1.3.2): 

1.4 DL        (CSA 8.3.2, Table C.1, Case 1) 
1.25 DL + 1.50 LL      (CSA 8.3.2, Table C.1, Case 2) 

1.25 DL  1.40 WL       (CSA 8.3.2, Table C.1, Case 4) 
0.90 DL  1.40 WL      (CSA 8.3.2, Table C.1, Case 4) 
1.25 DL + 0.5 LL   1.40 WL                 (CSA 8.3.2, Table C.1, Case 4) 

1.00 DL  1.00 EL      (CSA 8.3.2, Table C.1, Case 5) 
1.00 DL + 0.50 LL   1.00 EL    (CSA 8.3.2, Table C.1, Case 5) 

 
These are also the default design load combinations in the program whenever 
the CSA A23.3-04 code is used. In generating the preceding default loading 
combinations, the importance factor is taken as 1. The user should use other 
appropriate design load combinations if roof live load is separately treated, or 
if other types of loads are present. PLL is the live load multiplied by the Pat-
tern Live Load Factor. The Pattern Live Load Factor can be specified in the 
Preferences.  

When using the CSA A23.3-04 code, the program design assumes that a 
P-delta analysis has been performed.  

3.3 Limits on Material Strength 
The upper and lower limits of cf  should be 80 MPa and 20 MPa respectively, 

for all framing types (CSA 8.6.1.1, 21.2.6.1). 

  80MPacf       (CSA 8.6.1.1, 21.2.6.1) 
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  20MPacf                    (CSA 8.6.1.1) 

The upper limit of yf should be 500 MPa for all frames (CSA 8.5.1, 21.2.7.1) 

When the compression strength of concrete used in design is beyond the given 
limits or when the yield strength of steel used in design exceeds the given lim-

its, the code does not cover such cases. The code allows use of cf  and yf be-

yond the given limits, provided special care is taken regarding the detailing and 
ductility (CSA 8.6.1.2, 21.2.7.1). 

The program does not enforce any of these limits for column P-M-M interac-
tion check or design and flexure design of beam. The specified strengths are 
used for design. The user is responsible for using the proper strength values 
while defining the materials. For shear design, special limits are applicable 
(CSA 11.3.4, 11.3.6.4, 21.2.6.3) and enforced in the program as described 
herein. 

The code allows the use of reinforcement with yf less than 400 MPa in mem-

bers resisting earthquake induced forces without any restriction. The program 
also allows the use of yf  greater than 400 MPa.  However, if yf is between 400 

MPa and 500 MPa, the code requires that increased strain be taken into account 
because higher-yield-strength steel, in general, reduces ductility (CSA 
21.2.7.1). The program also considers the increased strain through 
strain-compatibility relations during P-M-M interaction capacity calculations.  

3.4 Strength Resistance Factors 
The strength resistance factor , , is material dependent and is defined as 

   0.65for concrete andc   (CSA  8.4.2 ) 

   0.85for steel.s   (CSA  8.4.3a) 

In some special cases, a member resistance factor, ,m is used as an additional 

reduction factor in addition to c and s (CSA 8.4.1). In connection with buck-

ling resistance, m  is taken as 0.75 (CSA 10.15.3.1). The values of c and s  

given herein are the default values. These values can be modified in the Pref-
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erences. For structural concrete manufactured in pre-qualified manufacturing 
plants, c can be taken as 0.7 (CSA 8.4.2, 16.1.3). 

3.5 Column Design 
The user may define the geometry of the reinforcing bar configuration of each 
concrete column section. If the area of reinforcing is provided by the user, the 
program checks the column capacity. However, if the area of reinforcing is not 
provided by the user, the program calculates the amount of reinforcing required 
for the column. The design procedure for the reinforced concrete columns of 
the structure involves the following steps: 

 Generate axial force/biaxial moment interaction surfaces for all of the dif-
ferent concrete section types of the model. A typical biaxial interaction sur-
face is shown in Figure 3-1. When the steel is undefined, the program 
generates the interaction surfaces for the range of allowable reinforcement ― 
1 to 8 percent for Conventional, Moderately Ductile resisting frames (CSA 
10.9.1 and CSA 10.9.2) and 1 to 6 percent for Ductile moment resisting 
frames (CSA 21.4.3.1). 

 Calculate the capacity ratio or the required reinforcing area for the factored 
axial force and biaxial (or uniaxial) bending moments obtained from each 
loading combination at each station of the column. The target capacity ratio 
is taken as one when calculating the required reinforcing area. 

 Design the column shear reinforcement. 

The following three subsections describe in detail the algorithms associated 
with this process. 

3.5.1 Generation of Biaxial Interaction Surfaces 
The column capacity interaction volume is numerically described by a series of 
discrete points that are generated on the three-dimensional interaction failure 
surface. In addition to axial compression and biaxial bending, the formulation 
allows for axial tension and biaxial bending considerations. A typical interac-
tion surface is shown in Figure 3-1.  
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Figure 3-1 A typical column interaction surface 

The coordinates of these points are determined by rotating a plane of linear 
strain in three dimensions on the section of the column. See Figure 3-2. The 
linear strain diagram limits the maximum concrete strain,  ,c at the extremity 

of the section to 0.0035 (CSA 10.1.3). 

The formulation is based consistently on the general principles of ultimate 
strength design (CSA 10.1), and allows for any doubly symmetric rectangular, 
square, or circular column section. 
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Figure 3-2 Idealized strain distribution for generation of interaction surface 

The stress in the steel is given by the product of the steel strain and the steel 
modulus of elasticity, ,s sE and is limited to the yield stress of the steel, yf  

(CSA 8.5.3.2).  The area associated with each reinforcing bar is assumed to be 
placed at the actual location of the center of the bar, and the algorithm does not 
assume any further simplifications in the manner in which the area of steel is 
distributed over the cross-section of the column (such as an equivalent steel 
tube or cylinder), as shown in Figure 3-3.  
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Figure 3-3 Idealization of stress and strain distribution in a column section 

The concrete compression stress block is assumed to be rectangular, with a 

stress value of 1 cf  (CSA 10.1.7).  See Figure 3-3. The depth of the stress 

block is 1 ,c where 

 1 10.85 0.0015 , 0.67cf      (CSA 10.1.7) 

 1 10.97 0.0025 , 0.67.cf      (CSA 10.1.7) 

The interaction algorithm provides a correction to account for the concrete area 
that is displaced by the reinforcement in the compression zone. 

The effects of the strength reduction factors are included in the generation of 
the interaction surfaces. The maximum compressive axial load is limited to 

r,max ,P where the maximum factored axial load resistance is given by 

  r,max 10.80  (tied column)c c g st s y stP f A A f A       
  (CSA  10.10.4) 

  ,max 10.80  (spiral column).r c c g st s y stP f A A f A       
 (CSA 10.10.4) 
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3.5.2 Calculate Column Capacity Ratio 
The column capacity is checked for each loading combination at each check 
station of each column. In checking a particular column for a particular loading 
combination at a particular location, the program uses the following steps: 

 Determine the factored moments and forces from the load cases and the 
specified load combination factors to give ,fP ,fxM and .fyM  

 Determine the moment magnification factors for the column moments. 

 Apply the moment magnification factors to the factored loads obtained in the 
first step. Determine whether the point, defined by the resulting axial load 
and biaxial moment set, lies within the interaction volume.  

The following three sections describe in detail the algorithms associated with 
this process. 

3.5.2.1 Determine Factored Moments and Forces 

The factored loads for a particular load combination are obtained by applying 
the corresponding load factors to all the load conditions, giving ,fP ,fxM and 

.fyM  The computed moments are further amplified by using “Moment Magni-

fication Factors” to allow for “Lateral Drift Effect” and “Member Stability Ef-
fect.” 

3.5.2.2 Determine Moment Magnification Factors 
The moment magnification factors are applied in two stages. First the moments 
are separated into their “sway” and “non-sway” components. The sway com-
ponents are amplified for lateral drift effect (CSA 10.16). Although according 
to the code, this amplification is significant for “unbraced” frames only and 
may be avoided for “braced” frames, the program treats all frames uniformly to 
amplify non-sway components of moments. These amplified moments are fur-
ther amplified for individual member stability effect. According to the code, 
the individual member stability effect is only significant if: 
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, for non-sway frames, and
f

c g

M

MkL
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




     (CSA 10.15.2) 

  
35

, for sway frames.
f

c g

kL

r P

f A





   (CSA 10.16.4) 

However, the program considers individual member stability effect for all 
compression column elements. 

3.5.2.2.1 Lateral Drift Effect 
For all frames, the moment magnification factor for lateral drift effect is ap-
plied only to the “sway” moment in the program.  

 ns s sM M M   (CSA 10.16.2) 

The moment obtained from analysis is separated into two components: the 
sway  sM and the non-sway  nsM  components. The non-sway or braced 

components, which are identified by “ns” subscripts are predominantly caused 
by gravity load. The sway components are identified by “s” subscripts. The 
sway moments are predominantly caused by lateral loads and are related to the 
cause of sidesway. 

The moment magnification factors in the major and minor directions can, in 
general, be different. The moment magnification factors for moments causing 
sidesway, sx and  ,sy can be taken as 1.0 if a P-delta analysis is carried out 

(CSA 10.16.3.1). The program assumes that a P-delta analysis has been per-
formed and, therefore, moment magnification factors for moments causing 
sidesway are taken as unity. For the P-delta analysis the load should corre-
spond to a load combination of (1.25 DL + 1.40 LL)/ m  (CSA 10.16.5), 

where m  is the strength reduction factor for stability and is equal to 0.75 

(CSA 10.15.3). See also White and Hajjar (1991).  
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The user is reminded of the special analysis requirements, especially those re-
lated to the value of EI used in analysis (CSA 10.14.1). The program analysis 
uses the EI of the gross cross-sectional area in conjunction with a multiplica-
tion factor. The multiplication factors are defined on a section-by-section basis, 
so that the effect of axial force and cracking can be modeled in a first order 
analysis. 

If the program assumptions are not satisfactory for a particular member, the 
user can explicitly specify values of sx and .sy  

3.5.2.2.2 Member Stability Effects 
All compression members are designed using the factored axial load, ,fP from 

the analysis and a magnified factored moment, .cM  The magnified moment is 

computed as, 

 2 2 ,c bM M M    (CSA 10.15.3.1) 

where 2M is the column maximum end moment obtained from elastic analysis 

after considering minimum eccentricity and lateral drift effect, and cM is the 

maximum moment occurring at the end or at an interior point within the span 
of the column. The moment magnification factor, ,b for moments not causing 

sidesway associated with the major or minor direction of the column is given 
by 

 1.0,  where

1

m
b

f

m c

C
P

P





 


  (CSA 10.15.3.1) 

  0.75, m   (CSA 10.15.3.1) 

 
 

2

2c

EI
P

kL


 ,   (CSA 10.15.3.1) 

k  is conservatively taken as 1, however the user can overwrite the value,  

EI  is associated with a particular column direction given by 
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0.4

,
1

c g

d

E I
EI





 and  (CSA 10.15.3.1) 

 0.6 0.4 0.4,a
m

b

M
C

M
     (CSA 10.15.3.2) 

aM and bM are the moments at the ends of the column, and bM is numerically 

larger than .aM   a bM M is positive for single curvature bending and negative 

for double curvature bending. The preceding expression of mC is valid if there 

is no transverse load applied between the supports. If transverse load is present 
on the span, or the length is overwritten, or for any other case, 1mC   (CSA 

10.15.3.3). mC can be overwritten by the user on an element- by-element basis. 

The pre-magnified factored moments are increased, if required, to obtain 
minimum eccentricities such that fM P is at least  15 0.03 mmh about each 

axis separately, where h  is the dimension of the column in mm units in the 
corresponding direction (CSA 10.15.3.1).  

  15 0.03fM P h    (CSA 10.15.3.1) 

The moment magnification factor, b , must be a positive number and greater 

than one. Therefore fP must be less than m cP . If fP is found to be greater 

than or equal to ,m cP  a failure condition is declared.  b  is taken as 1 for ten-

sion members. 

The preceding calculations use the unsupported length of the column. The two 
unsupported lengths are 22l  and 33l  corresponding to instability in the minor 

and major directions of the element, respectively. These are the lengths be-
tween the support points of the element in the corresponding directions. 

If the program assumptions are not satisfactory for a particular member, the 
user can explicitly specify values of s and b . 



Chapter 3 - Design Process 
 

 Column Design 3 - 15 

3.5.2.3 Determine Capacity Ratio 

As a measure of the stress condition of the column, a capacity ratio is calcu-
lated. The capacity ratio is basically a factor that gives an indication of the 
stress condition of the column with respect to the capacity of the column. 

Before entering the interaction diagram to check the column capacity, the mo-
ment magnification factors are applied to the factored loads to obtain ,fP ,fxM  

and .fyM  The point ( ,fP ,fxM fyM ) is then placed in the interaction space, 

shown as point L in Figure 3-4. If the point lies within the interaction volume, 
the column capacity is adequate; however, if the point lies outside the interac-
tion volume, the column is overstressed. 

 
Figure 3-4 Geometric representation of column capacity ratio 
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This capacity ratio is achieved by plotting the point L and determining the lo-
cation of point C.  The point C is defined as the point where the line OL (if ex-
tended outwards) will intersect the failure surface. This point is determined by 
three-dimensional linear interpolation between the points that define the failure 

surface.  See Figure 3-4. The capacity ratio, CR, is given by the ratio .
OL

OC
 

 If OL = OC (or CR = 1) the point lies on the interaction surface and the 
column is stressed to capacity. 

 If OL < OC (or CR < 1) the point lies within the interaction volume and the 
column capacity is adequate. 

 If OL > OC (or CR > 1) the point lies outside the interaction volume and the 
column is overstressed. 

The maximum of all the values of CR calculated from each load combination is 
reported for each check station of the column, along with the controlling ,fP  

,fxM and fyM set and associated load combination number. 

If the reinforcing area is not defined, the program computes the reinforcement 
that will give an interaction ratio of unity. 

3.5.3 Required Reinforcing Area 
If the reinforcing area is not defined, the program computes the reinforcement 
that will give a column capacity ratio equal to the Utilization Factor Limit, 
which is set to 0.95 by default.  

3.5.4 Design Column Shear Reinforcement 
The shear reinforcement is designed for each loading combination in the major 
and minor directions of the column. In designing the shear reinforcing for a 
particular column for a particular loading combination due to shear forces in a 
particular direction, the program uses the following steps: 
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 Determine the factored forces acting on the section, ,fM ,fP and .fV  Note 

that fM and fP are needed for the calculation of .cv  

 Determine the shear stress, ,cv that can be resisted by concrete alone. 

 Calculate the reinforcement steel required to carry the balance. 

For Ductile and Moderately Ductile moment resisting concrete frames, the 
shear design of the columns is also based on the probable and nominal moment 
capacities, respectively, of the members in addition to the factored moments 
(CSA 21.4.5.1(b), 21.7.2.3(b)). Effects of the axial forces on the column mo-
ment capacities are included in the formulation. 

The following three sections describe in detail the algorithms associated with 
this process. 

3.5.4.1 Determine Section Forces 

In the design of the column shear reinforcement of a Conventional moment re-
sisting concrete frame, the forces for a particular load combination, namely, the 
column axial force, ,fP the column moment, ,fM and the column shear force, 

,fV in a particular direction are obtained by factoring the program load cases 

with the corresponding load combination factors. 

In the shear design of Ductile moment resisting frames (seismic design), the 
following are checked in addition to the requirement for Conventional moment 
resisting frames. In the design of Ductile moment resisting concrete frames, the 
design shear force, ,fV in a particular direction is also calculated from the 

probable moment capacities of the column associated with the factored axial 
force acting on the column (CSA 21.4.5.1(b)).  

For each load combination, the factored axial load, ,fP is calculated. Then, the 

positive and negative moment capacities, fM   and ,fM  of the column in a par-

ticular direction under the influence of the axial force fP are calculated using 

the uniaxial interaction diagram in the corresponding direction. The design 
shear force, ,fV is then given by 
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 f p D LV V V     (CSA 21.4.5.1(b)) 

where, PV is the shear force obtained by applying the calculated probable ulti-

mate moment capacities at the two ends of the column acting in two opposite 
directions. Therefore, PV is the maximum of 1PV and 2 ,PV where   

 
 

1 ,I J
P

M M
V

L
 and 

 
 

2 ,I J
P

M M
V

L
 where  

IM  , IM   = Positive and negative moment capacities at end I of the 

column using a steel yield stress value of yf  and no   

factors ( 1.0s c   ), 

JM  , JM   = Positive and negative moment capacities at end J of the 

column using a steel yield stress value of yf  and no   

factors ( 1.0s c   ), and 

L = Clear span of column. 

For Ductile moment resisting frames,  is taken as 1.25 (CSA  2.2, 21.4.5.1).   

D LV  is the contribution of shear force from the in-span distribution of gravity 

loads. For most of the columns, it is zero. 

The pV is enforced not to be greater than the factored shear force component 

from specified gravity load increased by d oR R (CSA 21.4.5.1). 

In the design of Moderately Ductile moment resisting frames (seismic), the 
shear capacity of the column is also checked for the nominal shear due to the 
nominal  1.0s c   moment capacities and the factored gravity load (CSA 

21.7.2.3), in addition to the design checks required for Conventional moment 
resisting frames. The procedure for calculating nominal moment capacity is the 
same as that for computing the probable moment capacity for Ductile moment 
resisting frames, except that is taken equal to 1 (CSA 2.2, 21.7.2.3a) rather 
than 1.25. The design shear strength is enforced not to be greater than the fac-
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tored shear force with the seismic load increased by d oR R (CSA 21.7.2.3b). 

See also Table 3-1 for details. 

3.5.4.2 Determine Concrete Shear Capacity 
Given the design force set  ,fM  ,fN  and ,fV the shear capacity provided by 

the concrete alone, ,cV is calculated as follows: 

    ,c c c wV f b d    (CSA 11.3.4) 

c  is the resistance factor for concrete. By default, it is taken as 0.65  

(CSA8.4.2). For concrete produced in a pre-qualified manufacturing plants, 
its value can be taken as 0.70 (CSA 16.1.3). This value can be overwritten 
in the Preferences. 

   is the strength reduction factor to account for low density concrete (CSA 
2.2). For normal density concrete, its value is 1 (CSA 8.6.5), which is the 
program default value. For concrete using lower density aggregate, the user 
can change the value of  in the material properties. The recommended 
values for  is as follows (CSA 8.6.5). 

 

1.00, for normal density concrete,

0.85, for semi-low-density concrete

in which all of the fine aggregate is natural sand,

0.75, for semi-low-density concrete

in which none of the fine aggregate is natural







  sand.

 

  is the factor for accounting for the shear resistance of cracked concrete 

(CSA 2.2). Its value is normally between 0.1 and 0.4. It is determine ac-
cording to section 11.3.6 of the Code, which is described in the sections 
that follow. 

wb  is the width of the cross-section resisting the shear perpendicular to the 

shear force direction. For columns with rectangular cross-sections, wb is 

taken as the width of the section perpendicular to the shear direction. For 
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columns with circular cross-sections, wb is taken as the average width ap-

propriate for shear direction. 

vd is the effective shear depth. It is taken as the greater of 0.9d or 0.72h,  

  max 0.9 ,0.72vd d h  (CSA 2.2) 

where d is the distance from the extreme compression fiber to the centroid of 
tension reinforcement, and h is the overall depth of the cross-section in the di-
rection of shear force. 

The value of the  factor is preferably determine using the Simplified method 

(CSA 11.3.6.3) if applicable. When the conditions of Simplified method do not 
apply, the General method (CSA 11.3.6.4) is used. For designing concrete 
column sections for shear force, the special value of  does not apply (CSA 

11.3.6.4) 

When the axial force is compressive, the specified yield strength of the longi-
tudinal reinforcing yf does not exceed 400 MPa, and the specified concrete 

strength 
cf does not exceed 60 MPa,  is determined in accordance with the 

Simplified method, as follows (CSA 11.6.3.3): 

 When the section contains at least the minimum transverse reinforcement,   

is taken as 0.18 (CSA 11.6.3.3a). 

   = 0.18 (CSA 11.6.3.a) 

 When the section contains no transverse reinforcement,  is determined 

based on the specified maximum nominal size of coarse aggregate, ga . 

For maximum-sized coarse aggregate not less than 20 mm,  is taken as: 

 
230

1000 vd
 


  (CSA 11.3.6.3 b) 

where vd is the effective shear depth expressed in millimeter, as described in 

preceding sections. 



Chapter 3 - Design Process 
 

 Column Design 3 - 21 

For maximum sized coarse aggregate less than 20 mm,  is taken as: 

 
230

1000 zes
 


 (CSA 11.3.6.3 (c)) 

where, 
35

0.85 .
15

 
ze z z

g

S S S
a

 (CSA 11.3.6.3.c) 

In the preceding expression, the crack spacing parameter, ,zeS shall be taken 

as the minimum of vd and the maximum distance between layers of distrib-

uted longitudinal reinforcement. However, zeS is conservatively taken as 

equal to .vd  

In summary, for simplified cases, can be expressed as follows: 

v

ze

0.18, if minimum transverse reinforcement is provided,

230
, if no transverse reinforcement provided, and 20mm,

1000+d

230
, if no transverse reinforcement provided, and 20mm.

1000+S

g

g

a

a






 






 

When the axial force is tensile, or  the specified yield strength of the longitu-

dinal reinforcing yf  > 400 MPa, or the specified concrete strength 
cf  > 60 

MPa,  is determined in accordance with the General method, as follows 

(CSA 11.3.6.1, 11.3.6.4): 

   
0.40 1300

1 1500 1000



 

 x zeS
 (CSA 11.3.6.4) 

In the preceding expression, the equivalent crack spacing parameter, zeS , is 

taken as equal to 300 mm if minimum transverse reinforcement is provided 
(CSA 11.3.6.4). Otherwise it is determines as stated in simplified method. 
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

 

 



300, if minimum transverse 

reinforcement is provided,

35
0.85 , otherwise.

15

ze

z z
g

S

S S
a

 

The longitudinal strain, ,x at mid-depth of the cross-section is computed 

from the following equation: 

 
0.5f v f f

x
s s

M d V N

s E A


 
  (CSA 11.3.6.4) 

In evaluating the ,x the following conditions apply: 

 fV  and fM are taken as positive quantities  (CSA 11.3.6.4a) 

 sA  is taken as the total area of longitudinal reinforcement in the column 

section. For the column section check option, the program uses the sum of 
user-defined reinforcement in the section. For the column section design 
option, the longitudinal reinforcement area is taken as the envelope of re-
inforcement required for all design load combinations. Actual provided re-
inforcement might be slightly higher than this quantity. The reinforcement 
should be developed to achieve full strength (CSA 11.3.6.3 b). 

 If the value of x  calculated from the preceding equation is negative, it is 

recalculated as follows: 

 


 
  



0.5
0.0002

2

f
f f

v
x

s s c ct

M
V Nd

E A E A
 (CSA 11.3.6.4 d) 

For sections closer than vd  from the face of the support, x  is calculated 

based on , ,andf f fM V N  at a section at a distance vd  from the face of the 

support (CSA 11.3.6.4 d). 
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If the axial tension is large enough to crack the flexural compression face 
of the section, the value of x  is increased by a factor of 2 (CSA 11.3.6.4 

e). The program uses a linear elastic stress distribution to check this condi-
tion. 

An upper limit on x is imposed as follows: 

0.003xe    (CSA 11.3.6.4 f) 

 x is positive for tensile action. 

 fN is positive for tensile action. 

For Ductile moment resisting frames, an upper limit on   of 0.10 is enforced 

(CSA 21.4.5.2) as follows: 

0.10   (CSA 21.4.5.2) 

In both the Simplified method and the General method, the shear strength of 
the section due to concrete, ,cv depends on whether the minimum transverse 

reinforcement is provided. To check this condition, the program performs the 
design in two passes. In the first pass, it is assumes that no transverse shear re-
inforcement is needed. When the program determines that shear reinforcement 
is need, the program performs the second pass with the assumption that at least 
minimum shear reinforcement is provided. 

3.5.4.3 Determine Required Shear Reinforcement 
The minimum possible factored shear resistance, r,maxV is computed as follows: 

r,max c0.25 .c wV f b d    (CSA 11.3.3)  

The shear reinforcement per unit spacing, ,vA s  is computed as follows: 

If ,f cV V  

0vA

s
  (CSA 11.3.5.1) 
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else if r,max c fV V V  

  tan






f cv

s yh v

V VA

s f d
  (CSA 11.3.3, 11.3.5.1) 

else if  r,maxfV V  

a failure condition is declared. (CSA 11.3.3) 

 A minimum area of shear reinforcement is provided in the following re-
gions (CSA 11.2.8.1):  

(a) in regions of flexural members where the factored shear force fV ex-

ceeds ,cV  

(b) in regions of beams and columns with an overall depth greater than 
750 mm, and 

(c) in regions of beams and columns where the factored torsion fT exceeds 

0.25 .crT  

 Where the minimum shear reinforcement is required by section CSA 
11.2.8.1, or by calculations, the minimum area of shear reinforcement per 
unit spacing is taken as: 

cv
w

y

fA
b

s f


      (CSA 11.2.8.2) 

 In the preceding, the term   is used. Here   is the angle of inclination of 
diagonal compressive stresses to the longitudinal axis of the member. The 
  value is normally between 22 to 44 degrees. It is determined according 
to Section 11.3.6 of the Code. 

Similar to the   factor, which was described previously, the value of   is 

preferably determined using the Simplified method (CSA 11.3.6.3), when-
ever applicable. The program uses the General method when the conditions 
for the Simplified methods are not satisfied (CSA 11.3.6.4). For designing 
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concrete column sections for shear forces, the special value of   does not 
apply (CSA 11.3.6.2). 

If the axial force is compressive, the specified yield strength of the longitu-
dinal reinforcing yf does not exceed 400 MPa, and the specified concrete 

strength cf  does not exceed 60 MPa,   is taken to be 35 degrees (CSA 

11.3.6.3). 

  o35  for 0or 400MPa or 60MPaf y cP f f      (CSA11.3.6.4) 

If the axial force is tensile, the specified yield strength of the longitudinal 

reinforcing yf > 400 MPa, and the specified concrete strength cf    60 

MPa,  is determined using the General method as follows (CSA 11.3.6.4). 

  29 7000 x    

for  0fP   or yf  400 MPa or cf   60 MPa    (CSA11.3.6.4) 

where x  is the longitudinal strain at the mid-depth of the cross-section for 

the factored load. The calculation procedure has been described in the pre-
ceding sections. 

The maximum of all of the calculated vA s values obtained from each load 

combination is reported for the major and minor directions of the column, 
along with the controlling shear force and associated load combination 
number. 

For all columns and at any station, the minimum area of transverse circular 
hoop reinforcement is imposed as follows: 

 0.45 1
4

gv c core

core yh

AA f h

s A f

 
  

 
 (CSA 10.9.4) 

In potential plastic hinge locations of Ductile moment resisting frames as 
described later, the minimum area of circular hoops and transverse stirrups 
is imposed as follows: 
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core

4
fv c

o yh

PA f h

s P f


  (Hoops) (CSA 21.4.4.2) 

core

core

0.45 1
4

 
  

 

gv c

yh

AA f h

s A f
 (Hoops) (CSA 21.4.4.2, 10.9.4) 

core0.09


v c

yh

A f
h

s f
 (Stirrups) (CSA 21.4.4.2) 

core
core

0.2 gv
n p

AA
K K h

s A
  (Stirrups) (CSA 21.4.4.2) 

where 
 

1

1

and
2

 


f
n p

o

Pn
K K

n P
 

Transverse reinforcement shall be provided over a length, ,ol from the face 

of each joint and on both sides of any section where flexural yielding can 
occur as a result of inelastic displacement of the frame. The length, ,ol is 

determined as follows: 

(a) where 0.5 , f c c gP f A ol shall not be less than 1.5 times the largest 

member cross-section dimension or 1/6 of the clear span of the mem-
ber; and 

(b) where 0.5 , f c c gP f A ol shall not be less than 2.0 times the largest 

member cross-section dimension or 1/6 of the clear span of the mem-
ber (CSA 21.4.4.5). 

The column shear reinforcement requirements reported by the program are 
based on the preceding considerations. Any other minimum stirrup re-
quirements to satisfy spacing or volumetric requirements must be investi-
gated independently of the program by the user. 
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3.6 Beam Design 
In the design of concrete beams, the program calculates and reports the re-
quired areas of steel for flexure and shear based on the beam moments, shears, 
load combination factors and other criteria described in the subsections that 
follow. The reinforcement requirements are calculated at a user-defined num-
ber of check stations along the beam span. 

All of the beams are designed for major direction flexure and shear only.  Ef-
fects due to any axial forces, minor direction bending, and torsion that may ex-
ist in the beams must be investigated independently by the user. 

The beam design procedure involves the following steps: 

 Design beam flexural reinforcement  

 Design beam shear reinforcement 

3.6.1 Design Beam Flexural Reinforcement 
The beam top and bottom flexural steel is designed at a user-defined number of 
design stations along the beam span. In designing the flexural-reinforcement 
for the major moment of a particular beam for a particular section, the program 
uses the following steps: 

 Determine the maximum factored moments 

 Determine the reinforcing steel 

3.6.1.1 Determine Factored Moments 

In the design of flexural reinforcement of Ductile (CSA 21.5), Moderately 
Ductile (CSA 21.7), or Conventional (CSA 21.8) moment resisting concrete 
frame beams, the factored moments for each load combination at a particular 
beam station are obtained by factoring the corresponding moments for different 
load cases with the corresponding load factors. The beam section is then de-
signed for the maximum positive fM  and maximum negative fM  factored 

moments obtained from all of the load combinations. 
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Positive beam moments produce bottom steel.  In such cases, the beam may be 
designed as a Rectangular or T beam. Negative beam moments produce top 
steel.  In such cases, the beam is always designed as a Rectangular section.  

3.6.1.2 Determine Required Flexural Reinforcement 
In the flexural reinforcement design process, the program calculates both the 
tension and compression reinforcement. Compression reinforcement is added 
when the applied design moment exceeds the maximum moment capacity of a 
singly reinforced section. The user has the option of avoiding the compression 
reinforcement by increasing the effective depth, the width, or the grade of con-
crete. 

The design procedure is based on the simplified rectangular stress block, as 
shown in Figure 3-5 (CSA 10.1.7).  

 
Figure 3-5 Rectangular beam design 

Furthermore, it is assumed that the compression carried by concrete is less than 
that which can be carried at the balanced condition (CSA 10.1.4). When the 
applied moment exceeds the moment capacity at the balanced condition, the 
area of compression reinforcement is calculated on the assumption that the ad-



Chapter 3 - Design Process 
 

 Beam Design 3 - 29 

ditional moment will be carried by compression and additional tension rein-
forcement. 

The design procedure used by the program for both rectangular and flanged 
sections (L and T beams) is summarized in the sections that follow. It is as-
sumed that the design ultimate axial force in a beam is negligible; hence, all of 
the beams are designed for major direction flexure and shear only.  

3.6.1.2.1 Design for Flexure of a Rectangular Beam 
In designing for a factored negative or positive moment, ,fM (i.e., designing 

top or bottom steel) the depth of the compression block is given by a , as 
shown in Figure 3-5, where, 

2

1

2 | |
,

 
  


f

c c

M
a d d

f b
  (CSA 10.1) 

where the value of c  is 0.65 (CSA 8.4.2) in the preceding and following 

equations. Also , 1, 1, and bc  are calculated as follows: 

1 0.85 0.0015 0.67,cf       (CSA 10.1.7) 

1 0.97 0.0025 0.67,   andcf          (CSA 10.1.7) 

 
700

.
700


b

y

c d
f

      (CSA 10.5.2) 

The balanced depth of the compression block is given by 

 1 .b ba c      (CSA 10.1.4, 10.1.7) 

 If   ba a  (CSA 10.5.2), the area of tensile steel reinforcement is then 

given by 

 .

2

f
s

s y

M
A

a
f d


  
 
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This steel is to be placed at the bottom if fM is positive, or at the top if 

fM is negative. 

 If   ba a (CSA 10.5.2), compression reinforcement is required and is cal-

culated as follows: 

The factored compressive force developed in the concrete alone is given by 

 ,  and  
cc a c bC f ba      (CSA 10.1.7) 

the factored moment resisted by the concrete and bottom steel is 

 .
2

   
 

b
fc

a
M C d  

The moment resisted by compression steel and tensile steel is 

 .fs f fcM M M   

So the required compression steel is given by 

  1

,fs
s

s s c c

M
A

f f d d  
 

   
 where 

0.0035 .s s y

c d
f E f

c

     
     (CSA 10.1.2 , 10.1.3) 

The required tensile steel for balancing the compression in concrete is 

1 ,

2



  
 

fc
s

b
y s

M
A

a
f d

 and 

the tensile steel for balancing the compression in steel is 

 
 2 .





fs

s
y s

M
A

f d d
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Therefore, the total tensile reinforcement 1 2 ,s s sA A A  and total com-

pression reinforcement is .sA   sA is to be placed at the bottom, and 
sA is 

to be placed at the top if fM is positive, and vice versa. 

3.6.1.2.2 Design for Flexure of a T Beam 

Flanged Beam Under Negative Moment 
In designing for a factored negative moment, ,fM (i.e., designing top steel), 

the contribution of the flange to the strength of the beam is ignored. The design 
procedure is therefore identical to the one used for Rectangular beams, except 
that in the corresponding equations, b is replaced by .b  

Flanged Beam Under Positive Moment 
If 0,fM  the depth of the compression block is given by (see Figure 3-6). 

2

1

2
.f

c c f

M
a d d

f b 
  


  (CSA 10.1) 

where the value of c  is 0.65 (CSA 8.4.2) in the preceding and following 

equations. See Figure 3-6. Also 1, 1, and bc are calculated as follows: 

 1 0.85 0.0015 0.67,cf          (CSA 10.1.7) 

 1 0.97 0.0025 0.67,   cf  and    (CSA 10.1.7) 

 
700

.
700


b

y

c d
f

   (CSA 10.5.2) 

The depth of the compression block under balanced condition is given by 

 1b ba c . (CSA 10.1.4, 10.1.7) 

 If ,sa d the subsequent calculations for sA are exactly the same as previ-

ously performed for the rectangular section design. However, in this case, 
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the width of the beam is taken as .fb Whether compression reinforcement 

is required depends on if .ba a  

 

Figure 3-6 T beam design 

 If ,sa d calculation for sA is performed in two parts. The first part is for 

balancing the compressive force from the flange, ,fC and the second part 

is for balancing the compressive force from the web, .wC As shown in, 

 1 .f c f w sC f b b d     (CSA 10.1.7) 

Therefore, 1




 f c
s

y s

C
A

f
and the portion of fM that is resisted by the flange 

is  

 .
2

s
ff f c

d
M C d    

 
 

Therefore, the balance of the moment, fM to be carried by the web is 

given by 

. fw f ffM M M  
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The web is a Rectangular section of dimensions wb and d , for which the 

depth of the compression block is recalculated as 

 2
1

1

2
.fw

c c w

M
a d d

f b 
  


  (CSA 10.1) 

 If 1  ba a  (CSA 10.5.2), the area of tensile steel reinforcement is then 

given by 

2
1

,

2

fw
s

s y

M
A

a
f d


  
 

 and 

 1 2. s s sA A A  

This steel is to be placed at the bottom of the T beam. 

 If 1  ba a  (CSA 10.5.2), compression reinforcement is required and is cal-

culated as follows: 

The factored compressive force in the concrete web alone is given by 

1 ,c c bC f ba    and     (CSA 10.1.7) 

the factored moment resisted by the concrete web and tensile steel is 

 .
2
b

fc

a
M C d

   
 

 

The moment resisted by compression steel and tensile steel is 

 .fs fw fcM M M   

Therefore, the compression steel is computed as 

  1

,
  

 
   

fs
s

s s c c

M
A

f f d d
 where 
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0.0035 .
     

s s y

c d
f E f

c
 (CSA 10.1.2, 10.1.3) 

The tensile steel for balancing compression in web concrete is 

 2 ,

2

fc
s

b
y s

M
A

a
f d 


  
 

 and 

the tensile steel for balancing compression in steel is 

 
 3 .





fs

s
y s

M
A

f d d
 

Total tensile reinforcement 1 2 3,s s s sA A A A   and total compression re-

inforcement is .sA   sA  is to be placed at the bottom and 
sA  is to be 

placed at the top. 

3.6.1.3 Minimum and Maximum Tensile Reinforcement 

The minimum flexural tensile steel required for a beam section is given by the 
minimum of the two limits: 

0.2
,c

s w
y

f
A b h

f


    or  (CSA 10.5.1.2) 

( )

4
.

3s s requiredA A  (CSA 10.5.1.3) 

In addition, the minimum flexural tensile steel provided in a T section with 
flange under tension is given by the limit: 

  0.004 .s w sA b b d   (CSA 10.5.3.1) 

An upper limit of 0.04 times the gross web area on both the tension reinforce-
ment and the compression reinforcement is arbitrarily imposed as follows: 
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0.04 Rectangular beam

0.04 T beams
w

bd
A

b d


 


 

0.04 Rectangular beam

0.04 T beams
w

bd
A

b d

  


 

3.6.1.4 Special Consideration for Seismic Design 
For Ductile moment resisting concrete frames (seismic design), the beam de-
sign satisfies the following additional conditions (see also Table 3-2 for a 
comprehensive listing): 

 The minimum longitudinal reinforcement shall be provided at both the top 
and the bottom. Any of the top and bottom reinforcement shall not be less 
than  min .sA  

 min

1.4
 ws

y

A b d
f

 (CSA 21.3.2.1) 

 The beam flexural steel is limited to a maximum given by 

0.025 .s wA b d  (CSA 21.3.2.1) 

 At any end (support) of the beam, the beam positive moment capacity  (i.e., 
associated with the bottom steel) would not be less than one-half of the beam 
negative moment capacity (i.e., associated with the top steel) at that end 
(CSA 21.3.2.2). 

 Neither the negative moment capacity nor the positive moment capacity at 
any of the sections within the beam would be less than one-fourth of the 
maximum of positive or negative moment capacities of any of the beam end 
(support) stations (CSA 21.3.2.2). 

For Conventional moment resisting concrete frames (seismic design), the beam 
design would satisfy the following conditions: 

 At any support of the beam, the beam positive moment capacity would not be 
less than one-third of the beam negative moment capacity at that end (CSA 
21.7.2.1.1). 

 Neither the negative moment capacity nor the positive moment capacity at 
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any of the sections within the beam would be less than one-fifth of the 
maximum of positive or negative moment capacities of any of the beam end 
(support) stations (CSA 21.7.2.1.1). 

Table 3-2: Design Criteria 

Type of 
Check/ 
Design 

Conventional 
Moment Resisting Frames

(Non-Seismic) 

Moderately Ductile Moment
Resisting Frames 

(Seismic) 

Ductile Moment 
Resisting Frames 

(Seismic) 

Strength of 
Materials 

 cf    80 MPa 

 cf    500 MPa 

 cf    8 MPa 

 cf    80 MPa 

 cf    500 MPa 

 cf    8 MPa 

 cf    80 MPa 

 cf    500 MPa 

 cf    8 MPa 

Column 
Check 
(interaction) 

NLDa Combinations NLDa Combinations NLDa Combinations 

Column 
Design 
(Interaction) 

NLDa Combinations 
1% <  < 8% 

NLDa Combinations 
1% <  < 8% 

NLDa Combinations 
1% <  < 6% 

 = 1.0 

Column 
Shears 

NLDa Combinations 
 
 
 
 
 
 
 

Minimum hoop 

Modified NLDa Combinations 
or Nominal Capacity Shear (Vp) 
 = 1.0 and  = 1.0 
 
 
 
 
 

Minimum hoop reinforcement 

NLDa Combinations and 
Probable Capacity Shear (Vp) 

 = 1.0 and  = 1.25 
Strength based on 
  0.1,   45 at potential plastic 
hinge region 

Minimum hoop reinforcement 
Special reinforcement in hinge 

Beam 
Design 
Flexure 

 NLDa Combinations 
   0.04 

   0.2 c yf f  

 NLDa Combinations 
   0.04 

   0.2 c yf f  

 NLDa Combinations 
   0.04 

   0.2 c yf f  

Beam Min. 
Moment 
Override 
Check 

No Requirement 

1

3
uEND uENDM M   

 1

5
u uuSPAN

END
M max M ,M    

 1

5
uSPAN u u

END
M max M ,M    

1

2
uEND uENDM M   

 1

4
u uuSPAN

END
M max M ,M    

 1

4
uSPAN u u

END
M max M ,M    

Beam 
Design 
Shear 

NLDa Combinations NLDa Combinations or Nominal 
Capacity Shear (Vp) with  = 1.0 
and  = 1.0 plus VD+L, or modified 
load combination with earthquake 
load amplified by RdRo. 

 

NLDa Combinations and 
Probable Capacity Shear  (Vp) 
with   = 1.0 and  = 1.0 plus 
VD+L, or modified load 
combination with earthquake load 
amplified by RdRo;  strength 
based on  = 0 and  = 45 degree 
in potential plastic hinge. 
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3.6.2 Design Beam Shear Reinforcement 
The shear reinforcement is designed for each load combination at a 
user-defined number of stations along the beam span. In designing the shear 
reinforcement for a particular beam for a particular loading combination at a 
particular station due to the beam major shear, the program uses the following 
steps: 

 Determine the factored forces acting on the section, fM  and .fV  Note that 

fM  is needed for the calculation of .cv  

 Determine the shear stress, ,cv that can be resisted by concrete alone. 

 Calculate the reinforcement steel required to carry the balance. 

For Ductile and Moderately ductile moment resisting frames, the shear design 
of the beams is also based on the probable and nominal moment capacities of 
the members, respectively (CSA 21.3.4.1, 21.7.2.3). 

The following three sections describe in detail the algorithms associated with 
these steps. 

3.6.2.1 Determine Shear Force and Moment 

In the design of the beam shear reinforcement of an Conventional moment re-
sisting concrete frame, the shear forces and moments for a particular load 
combination at a particular beam section are obtained by factoring the associ-
ated shear forces and moments with the corresponding load combination fac-
tors.  

In the design of Ductile moment resisting concrete frames (seismic design), the 
shear capacity of the beam is also checked for the probable shear due to the 
probable moment capacities and the factored gravity load, in addition to the 
design checks required for Conventional moment resisting frames. The proce-
dure for calculating the design shear force in a beam from probable moment 
capacities is the same as that described for a column in the Column Design sec-
tion. See also Table 3-2 and Figure 3-7 for more details. The design shear force 

fV  is then given by  

 f p D LV V V  (CSA 21.3.4.1) 
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where, pV is the shear force obtained by applying the calculated probable ulti-

mate moment capacities at the two ends of the beams acting in two opposite 
directions. Therefore, pV is the maximum of 1PV and 2 ,PV where   

 1 ,P I JV M M L    and 

 2 ,P I JV M M L    where  


IM  =  Moment capacity at end I, with bottom steel in tension, using a 

steel yield stress value of yf  and no   factors 

( 1.0s c   ), 

JM    =  Moment capacity at end J, with bottom steel in tension, using a 

steel yield stress value of  yf  and no   factors ( 1.0  s c ), 


IM  = Moment capacity at end I, with top steel in tension, using a steel 

yield stress value of  yf  and no   factors ( 1.0  s c ), 


JM   =  Moment capacity at end J, with top steel in tension, using a steel 

yield stress value of  yf   and no   factors ( 1.0  s c ), and 

L      =  Clear span of beam. 

The overstrength factor   is always taken as 1.25 for Ductile moment resisting 
frames (CSA 2.2, 21.3.4.1).  D LV  is the contribution of shear force from the 

in-span distribution of gravity loads.  

In the design of Moderately Ductile moment resisting frames (seismic), the 
shear capacity of the beam is also checked for the nominal shear due to the 
nominal  ( 1.0  s c ) moment capacities and the factored gravity load (CSA 

21.7.2.3(a), 2.2), in addition to the design checks required for Conventional  
moment resisting frames. The procedure for calculating nominal moment ca-
pacity is the same as that for computing the probable moment capacity for 
Ductile moment resisting frames, except that   is taken equal to 1 (CSA 
21.7.2.3.(a), 2.2) rather than 1.25. The design shear strength is enforced not to 
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be greater than the factored shear force with the seismic load amplified by a 
factor of d oR R  (CSA 21.3.4.1, 21.7.2.3(b)). See also Table 3-2 for details. 
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Figure 3-7 Column shear force Vu 

3.6.2.2 Determine Concrete Shear Capacity 
Given the design force set fM and ,fV the shear capacity provided by the con-

crete alone, ,cV is calculated as follows: 

 ,c c c wV f b d    (CSA 11.3.4) 
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c  is the resistance factor for concrete. By default it is taken as 0.65 

(CSA8.4.2). For concrete produced in a pre-qualified manufacturing plants, 
its value can be taken as 0.70 (CSA 16.1.3). This value can be overwritten 
in the Preferences. 

  is the strength reduction factor to account for low density concrete (CSA 
2.2). For normal density concrete, its value is 1 (CSA 8.6.5), which is taken 
by the program as the default value. For concrete using lower density ag-
gregate, the user can change the value of   in the material property data. 
The recommended value for   is as follows (CSA 8.6.5). 

 

1.00, for normal density concrete,

0.85, for semi-low-density concrete

in which all of the fine aggregate is natural sand,

0.75, for semi-low-density concrete

in which none of the fine aggregate is natural







  sand.

 

  is the factor for accounting for the shear resistance of cracked concrete 

(CSA 2.2). Its value is normally between 0.1 and 0.4. It is determine ac-
cording to the section 11.3.6  of the Code, which is described in the sec-
tions that follow. 

wb  is the effective web width. For rectangular beam, it is the width of the 

beam. For T beam, it is the width of the web of the beam. 

vd  is the effective shear depth. It is taken as the greater of 0.9d or 0.72h,  

  max 0.9 ,0.72vd d h    (CSA 2.2) 

where d is the distance from the extreme compression fiber to the centroid of 
tension reinforcement, and h is the overall depth of the cross-section in the di-
rection of shear force. 

The value of the   factor is preferably taken as the Special value (CSA 

11.3.6.2) or it is determined using the Simplified method (CSA 11.3.6.3), if 
applicable. When the conditions of  the Special value or Simplified method do 
not apply, the General method is used to determine the  factor (CSA 

11.3.6.4). 
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If the overall beam depth, h, is less than 250 mm or if the beam depth of a  
T beam before the slab is not greater than one-half of the width of web or 350 
mm,  is taken as 0.21 (CSA 11.3.6.2) 

When the specified yield strength of the longitudinal reinforcing yf does not 

exceed 400 MPa, and the specified concrete strength 
cf does not exceed 60 

MPa,  is determined in accordance with the Simplified method, as follows 

(CSA 11.6.3.3): 

 When the section contains at least the minimum transverse reinforcement,   

is taken as 0.18 (CSA 11.6.3.3a). 

   = 0.18  (CSA 11.6.3.a) 

 When the section contains no transverse reinforcement,  is determined 

based on the specified maximum nominal size of coarse aggregate, ga . 

For maximum size of coarse aggregate not less than 20 mm,  is taken as: 

230

1000
 

 vd
 (CSA 11.3.6.3 b) 

where is the effective shear depth expressed in millimeter, which is described 
in preceding sections. 

For maximum size of coarse aggregate less than 20 mm,    is taken as: 

230

1000
 

 zes
 (CSA 11.3.6.3 c) 

where,  
35

0.85
15

 
ze z z

g

S S S
a

  (CSA 11.3.6.3.c) 

In the preceding expression, the crack spacing parameter, ,zeS shall be taken 

as the minimum of vd and the maximum distance between layers of distrib-

uted longitudinal reinforcement. However, zeS is conservatively taken as 

equal to .vd  
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In summary, for Simplified cases,  can be expressed as follows: 

0.18, if minimum transverse reinforcement is provided,

230
, if no transverse reinforcement provided, and 20mm,

1000

230
, if no transverse reinforcement provided, and 20mm.

1000

g
v

g
ze

a
d

a
S






 







 

 When the specified yield strength of the longitudinal reinforcing yf > 400 

MPa, or the specified concrete strength 
cf > 60 MPa,  is determined in 

accordance with the General method as follows (CSA 11.3.6.1, 11.3.6.4): 

   
0.40 1300

1 1500 1000



 

 x zeS
  (CSA 11.3.6.4) 

In the preceding expression, the equivalent crack spacing parameter, ,zeS is 

taken as equal to 300 mm if minimum transverse reinforcement is provided 
(CSA 11.3.6.4). Otherwise it is determine as stated in the Simplified method. 

300 if minimum transverse reinforcement is provided,

35
0.85 otherwise.

15
ze

z z
g

S
S S

a


   

 

The longitudinal strain, , x at mid-depth of the cross-section is computed 

from the following equation: 

 



 f v f

x
s s

M d V

s E A
 (CSA 11.3.6.4) 

In evaluating the , x the following conditions apply: 

fV and fM  are taken as positive quantities  (CSA 11.3.6.4a) 

sA is taken as the total area of longitudinal reinforcement in the beam 

section. It is taken as the envelope of reinforcement required for all de-
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sign load combinations. Actual provided reinforcement might be slightly 
higher than this quantity. The rebar should be developed to achieve full 
strength (CSA 11.3.6.3 b). 

For sections closer than vd from the face of the support,  x is calculated 

based on fM and fV at a section at a distance vd from the face of the 

support (CSA 11.3.6.4 d). 

An upper limit on  x is imposed as follows: 

 0.003xe   (CSA 11.3.6.4 f) 

 x is positive for tensile action. 

 For Ductile moment resisting frames, in the region of potential plastic hinge, 
the shear reinforcement is designed assuming  is equal to zero: 

0    (CSA 21.3.4.2) 

In both the Simplified and General methods, the shear strength of the section 
due to concrete, ,cv depends on whether the minimum transverse reinforce-

ment is provided. To check this condition, the program performs the design 
in two passes. In the first pass, it is assumes that no transverse shear rein-
forcement is needed. When the program determines that shear reinforcement 
is need, the program performs the second pass with the assumption that at 
least minimum shear reinforcement is provided. 

3.6.2.3 Determine Required Shear Reinforcement 
The minimum possible factored shear resistance, r,maxV is computed as follows: 

r,max 0.25 .c c wV f b d   (CSA 11.3.3)  

The shear reinforcement per unit spacing, ,vA s is computed as follows: 

If f cV V  

0vA

s
 (CSA 11.3.5.1) 
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else if r,max c fV V V  

  tan






f cv

s yh v

V VA

s f d
  (CSA 11.3.3, 11.3.5.1) 

else if r,maxfV V  

a failure condition is declared. (CSA 11.3.3) 

A minimum area of shear reinforcement is provided in the following re-
gions (CSA 11.2.8.1):  

(a) in regions of flexural members where the factored shear force fV  ex-

ceeds ,cV  

(b) in regions of beams and columns with an overall depth greater than 
750 mm, and 

(c) in regions of beams and columns where the factored torsion fT exceeds 

0.25 . 

Where the minimum shear reinforcement is required by section CSA 
11.2.8.1, or by calculations, the minimum area of shear reinforcement per 
unit spacing is taken as .crT  

0.06


 cv
w

y

fA
b

s f
 (CSA 11.2.8.2) 

In the preceding, the term  is used. Here  is the angle of inclination of di-
agonal compressive stresses to the longitudinal axis of the member. The   

value is normally between 22 to 44 degree. It is determined according to sec-
tion 11.3.6 in the Code. 

Similar to the  factor, which was described previously, the value of  is 

preferably taken as the Special value (CSA 11.3.6.2) or it is determined using 
the Simplified method (CSA 11.3.6.3), whenever applicable. The program uses 
the General method when conditions for the Simplified method are not satis-
fied (CSA 11.3.6.4).  
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 If the overall beam depth, h, is less than 250 mm or if the depth of the  
T beam below the slab is not greater than one-half of the width of web or 350 
mm,  is taken as 42 degree (CSA 11.3.6.2). 

 If the specified yield strength of the longitudinal reinforcing yf does not ex-

ceed 400 MPa, and the specified concrete strength 
cf does not exceed 60 

MPa,  is taken to be 35 degree (CSA 11.3.6.3). 

o35   for 0fP  or 400yf MPa or  60 MPa (CSA11.3.6.4) 

 If the axial force is tensile, the specified yield strength of the longitudinal re-

inforcing yf  > 400 MPa, and the specified concrete strength 
cf  > 60 MPa, 

  is determined using the General method as follows (CSA 11.3.6.4), 

29 7000   x for 0fP or yf  400 MPa or 60 MPa  (CSA11.3.6.4) 

where x is the longitudinal strain at the mid-depth of the cross-section for 

the factored load. The calculation procedure has been described in preceding 
sections. 

The maximum of all of the calculated vA s values, obtained from each load 

combination, is reported for the major directions of the beam along with the 
controlling shear force and associated load combination number. 

The beam shear reinforcement requirements reported by the program are based 
purely on the considerations herein. Any other minimum stirrup requirements 
to satisfy spacing and volumetric requirements must be investigated independ-
ently of the program by the user. 

3.7 Joint Design 
To ensure that the beam-column joint of Ductile and Moderately Ductile mo-
ment resisting frames possesses adequate shear strength, the program performs 
a rational analysis of the beam-column panel zone to determine the shear 
forces that are generated in the joint. The program then checks this against de-
sign shear strength. 
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Only joints having a column below the joint are designed. The material proper-
ties of the joint are assumed to be the same as those of the column below the 
joint. 

The joint analysis is completed in the major and the minor directions of the 
column. The joint design procedure involves the following steps: 

 Determine the panel zone design shear force, h
uV   

 Determine the effective area of the joint 

 Check panel zone shear stress 

The following three sections describe in detail the algorithms associated with 
these steps. 

3.7.1 Determine the Panel Zone Shear Force 
For a particular column direction, major or minor, the free body stress condi-
tion of a typical beam-column intersection is shown in Figure 3-4. 

The force h
uV is the horizontal panel zone shear force that is to be calculated. 

The forces that act on the joint are ,fP ,fV L
fM and .R

fM  The forces fP  and fV   

are axial force and shear force, respectively, from the column framing into the 

top of the joint. The moments  L
fM and R

fM are obtained from the beams 

framing into the joint. The joint shear force h
uV is calculated by resolving the 

moments into C and T  forces. Noting that L LT C  and R RT C , 

   h
u L R uV T T V  

The location of C or T forces is determined by the direction of the moment. 
The magnitude of C or T forces is conservatively determined using basic prin-
ciples of ultimate strength theory (CSA 10.1). 

The moments and the forces from beams that frame into the joint in a direction 
that is not parallel to the major or minor direction of the column are resolved 
along the direction that is being investigated, thereby contributing force com-
ponents to the analysis. 



Chapter 3 - Design Process 
 

 Joint Design 3 - 47 

Also, the program calculates the positive and negative moments, considering 
the fact that the concrete cover may be different for the direction of moment.  

In the design of Ductile moment resisting concrete frames, the evaluation of 
the design shear force is based on the maximum probable moment capacities 
(with reinforcing steel overstrength factor, , and no  factors) of the beams 

framing into the joint (CSA 21.5.1.2, 21.7.2.4.1). In the design of Moderately 
Ductile moment resisting frames, the evaluation of the design shear force is 
based on the nominal capacities (with no reinforcing steel overstrength factor, 
i.e., 1,  and no  factors, i.e., 1  c s of the beams framing into the joint 

(CSA 21.7.2.4.1). The C and T force are based on these moment capacities. 
The program calculates the column shear force, ,uV from the beam moment 

capacities as follows: 

 ,




L R
u u

u beam

M M
V

H
 

It should be noted that the points of inflection shown on Figure 3-4 are taken as 
midway between actual lateral support points for the columns. If there is no 
column at the top of the joint, the shear force from the top of the column is 
taken as zero. 

The program also checks the capacity shear that can be developed in the col-
umn based on its positive and negative moment capacities for the presence of 
factored axial load, .fP  

 , min ,
        

  

top bot top bot
u u u u

u col

M M M M
V

H H
 

uV is taken as the minimum of the two values ,u beamV  and , .u colV  

  , ,min ,u u beam u colV V V  

The effects of load reversals, as illustrated in Case 1 and Case 2 of Figure 3-8 
are investigated, and the design is based on the maximum of the joint shears 
obtained from the two cases. 
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Figure 3-8 Beam-Column joint analysis 
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3.7.2 Determine the Effective Area of Joint 
The joint area that resists the shear forces is assumed always to be rectangular 
in plan view. The dimensions of the rectangle correspond to the major and mi-
nor dimensions of the column below the joint, except if the beam framing into 
the joint is very narrow. The effective width of the joint area to be used in the 
calculation is limited to two times the width of the beam. The area of the joint 
is assumed not to exceed the area of the column below. The joint area for joint 
shear along the major and minor directions is calculated separately (CSA 2.3). 

The effective joint shear area, ,JA is given by 

  min ,2J col col w colA b h b h  (CSA 2.3) 

where, 

colb  is the width of column section perpendicular to direction of shear, 

colh  is the depth of column section in the direction of shear, and 

 wb  is the width of the beam or its web. 

For circular column, both colb and colh are taken equal to the overall diameter of 

the column. For a section designer section, colb and colh are based on equiva-

lence. 

 
It should be noted that if the beam frames into the joint eccentrically, the pre-
ceding assumptions may not be conservative and the user should investigate 
the acceptability of the particular joint. 

3.7.3 Check Panel Zone Shear Stress 
The panel zone shear force h

uV is compared to the factored shear resistance of 

the joint  cV  (CSA 21.5.4.1, 21.7.2.4.2).  cV is calculated from the following 

equation: 
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2.2 , for joints confined on all four sides,

1.6 , for joints confined on three faces or on two opposite faces,

1.3 , for all other joints.

c c J

c c c J

c c J

f A

V f A

f A







 

  





 
c  is the resistance factor for concrete. By default, it is taken as 0.65 (CSA 

8.4.2). For concrete produced in a pre-qualified manufacturing plant, its 
value can be taken as 0.70 (CSA 16.1.3). Its value can be overwritten in the 
Preferences. 


cf  is the specified compressive strength of concrete. It is assumed to be the 

same as that of the column below the joint. The 
cf should not be greater 

than 8 MPa,  

 8MPa cf  

JA   is the effective joint shear area appropriate for the direction. 

A beam that frames into a face of a column at the joint is considered in the 
program to provide confinement to the joint if at least three-quarters of the face 
of the joint is covered by the framing member (CSA 21.5.4.1, 21.7.2.4.2). 

3.7.4 Beam-Column Flexural Capacity Ratios 
At a particular joint for a particular column direction, major or minor, the pro-
gram will calculate the ratio of the sum of the beam moment capacities to the 
sum of the column moment capacities. For Ductile and Moderately Ductile 
moment resisting frames, the following CSA provision must be satisfied (CSA 
21.4.2.2, 21.7.2.2.2).   

 c bM M  (CSA 21.4.2.2, 21.7.2.2.2) 

For Ductile moment resisting frames  cM and  bM are defined as follows: 
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  cM is the sum of the nominal flexural strength of columns, ,ncM framing 

into the joint evaluated at the center of the joint. Individual column flexural 
strength is calculated for the associated factored axial forces, .fP  The nomi-

nal capacity is calculated with no overstrength factor, i.e., 1,  and no 
 factors or 1.c s    

  bM is the sum of the maximum probable flexural strength of beams, 

,pbM  framing into the joint evaluated at the face of the joint. The probable 

capacity is calculated with an overstrength factor, i.e., 1.25,  and no   

factors or 1.c s    

For Moderately Ductile moment resisting frames,  cM and  bM are de-

fined as follows: 

  cM is the sum of the factored flexural strength of columns, ,ncM fram-

ing into the joint evaluated at the center of the joint. Individual column flex-
ural strength is calculated for the associated factored axial forces, .fP  The 

nominal capacity is calculated with no overstrength factor, i.e., 1,  and 
with appropriate c and s factors. 

  bM is the sum of the nominal flexural strength of beams, ,pbM framing 

into the joint evaluated at the face of the joint. The probable capacity is cal-
culated with an overstrength factor, i.e., 1,  and no  factors, i.e., 

1  c s . 

The moment capacities of beams that frame into the joint in a direction that is 
not parallel to the major or minor direction of the column are resolved along 
the direction that is being investigated and the resolved components are added 
to the summation. 

The column capacity summation includes the column above and the column 
below the joint. For each load combination, the factored axial force, ,fP in 

each of the columns is calculated from the load combinations. For each load 
combination, the moment capacity of each column under the influence of the 
corresponding factored axial load fP is then determined separately for the ma-

jor and minor directions of the column, using the uniaxial column interaction 
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diagram; see Figure 3-8. The moment capacities of the two columns are added 
to give the capacity summation for the corresponding load combination.  The 
maximum capacity summations obtained from all of the load combinations is 
used for the beam-column capacity ratio. 

The beam-column capacity ratio is determined for a beam-column joint only 
when the following conditions are met: 

 The frame is a Ductile or Moderately Ductile moment resisting frame. 

 When a column exists above the beam-column joint, it is a concrete column. 

 All of the beams framing into the column are concrete beams. 

 The connecting member design results are available. 

 The load combination involves seismic load. 

The beam-column flexural capacity ratios are reported only for Ductile and 
Moderately Ductile moment resisting frames involving seismic design load 
combinations. If this ratio is greater than 1.0, a warning message is printed in 
the output file.  
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Chapter 4 

Design Output 

4.1 Overview 
The program creates design output in different formats – graphical display, 
tabular output, and member specific detailed design information.  

The graphical display of design output includes input and output design infor-
mation. Input design information includes design section labels, K-factors, live 
load reduction factors, and other design parameters. The output design infor-
mation includes longitudinal reinforcing, shear reinforcing and column capac-
ity ratios. All graphical output can be printed.  

The tabular output can be saved in a file or printed. The tabular output includes 
most of the information that can be displayed. This is generated for added 
convenience to the designer. 

The member specific detailed design information shows the details of the cal-
culation from the designer’s point of view. It shows the design forces, design 
section dimensions, reinforcement, and some intermediate results for all of the 
load combinations at all of the design sections of a specific frame member. For 
a column member, it also can show the position of the current state of design 
forces on the column interaction diagram. 
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In the following sections, some of the typical graphical display, tabular output, 
spreadsheet output, and member specific detailed design information are de-
scribed. The CSA A23.3-04 design code is described in this manual.  

4.2 Graphical Display of Design Information 
The graphical display of design output includes input and output design infor-
mation. Input design information includes design section label, K-factors, live 
load reduction factor, and other design parameters. The output design informa-
tion includes longitudinal reinforcing, shear reinforcing, column capacity ratio, 
beam-column capacity ratio, joint shear check, and other design information.  

The graphical output can be produced in color or in gray-scaled screen display. 
The active screen display can be sent directly to the printer.  

4.2.1 Input and Output 
Input design information for the CSA A23.3-04 code includes the following: 

 Design sections 

 Design framing type 

 Live load reduction factors (RLLF) 

 Unbraced length, L-factors, for major and minor direction of bending 

 Effective length Factors, K-factors, for major and minor direction of bend-

ing 

 Cm factors, for major and minor direction of bending  

 ns factors, for major and minor direction of bending 

 s factors, for major and minor direction of bending 

The output design information that can be displayed consists of the following: 

 Longitudinal reinforcing area  

 Longitudinal reinforcing area as percent of concrete gross area 
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 Shear reinforcing areas per unit spacing  

 Column P-M-M interaction ratios 

 6
5  Beam-column capacity ratios 

 Column-beam capacity ratios 

 Joint shear capacity ratios 

 Torsion reinforcing 

 General reinforcing details 

Use the Design menu > Concrete Frame Design > Display Design Info 
command in SAP2000/ETABS and the Advanced > Frame Design > Con-
crete > Display Design Information command in CSiBridge to plot input and 
output values directly on the model in the active window. Clicking this com-
mand will access the Display Design Results form. Select the Design Output or 
Design Input option, and then use the drop-down lists to choose the type of de-
sign data to be displayed, such as longitudinal reinforcement, rebar percent-
ages, shear reinforcing and so on. Click the OK button on the form to close the 
form and display the selected data in the active window. 

The graphical displays can be viewed in 2D or 3D mode. Use the various tool-
bar buttons (e.g., Set Default 3D View, Set X-Y View) to adjust the view, or 
use the View menu > Set 2D View or View menu > Set 3D View commands 
in SAP2000/ETABS and the Home > View > Set 2D View or Set 3D 
View command in CSiBridge to refine the display. 

The graphical display in the active window can be printed by clicking the File 
menu > Print Graphics command in SAP2000/ETABS and the Orb > Print 
> Print Graphics command in CSiBridge, the Print Graphics button on the 
toolbar, or the Ctrl+G keyboard shortcut. The display also can be captured as a 
bit map file (.bmp) using one of the subcommands on the File menu > Cap-
ture Picture command in SAP2000/ETABS and the Orb > Picture command 
in CSiBridge, or as a metafile (.emf) using one of the subcommands on the File 
menu > Capture Enhanced Metafile command in SAP2000/ETABS and the 
Orb > Picture > Metafile command in CSiBridge. The captured picture file 
can then be used in popular graphics programs, including Paint and Power-
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Point. Alternatively, the standard Windows screen capture command (click the 
Print Screen button on the keyboard) can be used to create a screen capture of 
the entire window, or use the Alt+Print Screen command to capture only the 
"top layer," such as a form displayed from within the program. 

By default, graphics are displayed and printed in color, assuming a color 
printer is available. Use the Options menu > Colors > Output command in 
SAP2000/ETABS and the Orb > Settings > Colors command in CSiBridge to 
change default colors, as necessary, including changing the background color 
from the default black to white. A white background can be useful when print-
ing design output to save ink/toner. In addition, the Options menu > Colors > 
Set Active Theme command can be used to view or print graphics in grayscale 
in SAP2000/ETABS. 

4.3 Tabular Display of Design Output 
The tabular design output can be sent directly to a printer or saved to a file. The 
printed form of the tabular output is the same as that produced for the file out-
put except that the font size is adjusted for the printed output. 

 The tabular design output includes input and output design information that 
depends on the design code chosen. For the CSA A23.3-04 code, the tabular 
output includes the following. All tables have formal headings and are 
self-explanatory, so further description of these tables is not given. 

Input design information includes the following: 
 

 Concrete Column Property Data  
- Material label 
- Column dimensions 
- Reinforcement pattern 
- Concrete cover 
- Bar area 

 

 Concrete Beam Property Data  
- Material label 
- Beam dimensions 
- Top and bottom concrete cover 
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- Top and bottom reinforcement areas 
 

 Concrete Column Property Data  
- Material label 
- Column dimensions 
- Reinforcement pattern 
- Concrete cover 
- Bar area 

 

 Load Combination Multipliers 
- Combination name 
- Load types 
- Load factors 

 
 Concrete Design Element Information 

- Design section ID 
- Factors for major and minor direction of bending 
- Unbraced length ratios for major and minor direction of  

bending, L-factors 
- Live load reduction factors (RLLF) 

 
 Concrete Moment Magnification Factors 

- Section ID 
- Element Type 
- Framing Type 
- ns -factors 
- s -factors 

 
The output design information includes the following:  
 
 Column design Information 

- Section ID 
- Station location 
- Total longitudinal reinforcement and the governing load combination 
- Major shear reinforcement and the governing load combination 
- Minor shear reinforcement and the governing load combination 
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 Beam Design Information 
- Section ID 
- Station location 
- Top longitudinal reinforcement and the governing load combination 
- Bottom reinforcement and the governing load combination 
- Longitudinal torsional reinforcement and the governing load combi-

nation 
- Major shear reinforcement and the governing load combination for 

shear and torsion design 
 
 Concrete Column Joint Information 

- Section ID 
- (6/5) Beam/column capacity ratios for major and minor direction and 

the governing load combination 
- Joint shear capacity for major and minor direction and the governing 

load combination 
 
Tabular output can be printed directly to a printer or saved in a file using the 
File menu > Print Tables command in SAP/ETABS and the Orb > Print > 
Print Tables command in CSiBridge. A form will display when this com-
mand is used. Depress the F1 key on the keyboard to access the Help topic 
specific to that form, which will identify the types of output available (e.g., 
plain text with or without page breaks, rich text format Word document, and so 
on).  
 

4.4 Member Specific Information 
Member specific design information shows the details of the calculation from 
the designer's point of view. It includes the geometry and material data, other 
input data, design forces, design section dimensions, reinforcement details, and 
some of the intermediate results for the selected member. The design detail in-
formation can be displayed for a specific load combination and for a specific 
station of a column or beam member. For columns, member specific design 
information also can show the position of the current state of design forces us-
ing a column interaction diagram. 

After an analysis has been performed and the Design menu > Concrete 
Frame Design > Start Design/Check command in SAP2000/ETABS and the 
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Advanced > Frame Design > Concrete > Start Design/Check of Structure 
command in CSiBridge has been used, access the detailed design information 
by right clicking a frame member to display the Concrete Column Design In-
formation form if a column member was right clicked or the Concrete Beam 
Design Information form if a beam member was right clicked. Table 4-1 iden-
tifies the types of data provided by the forms. 

The longitudinal and shear reinforcing area are reported in their current units, 
which are displayed in the drop-down list in the lower right corner of the pro-
gram window. Typically, the longitudinal reinforcing area is reported in in2, 
mm2, cm2 and so on. Shear reinforcing areas typically are reported in in2/in, 
mm2/mm, cm2/cm and so on.  

 
Table 4-1 Member Specific Data for Columns and Beams 

Column Beam 

 Load combination ID 

 Station locations 

 Longitudinal reinforcement area 

 Major shear reinforcement areas 

 Minor shear reinforcement areas 

 Load combination ID 

 Station location 

 Top reinforcement areas 

 Bottom reinforcement areas 

 Longitudinal reinforcement for torsion design 

 Shear reinforcement area for shear  

 Shear reinforcement area for torsion design 

Buttons on the forms can be used to access additional forms that provide the following data 

 Overwrites 
– Element section ID 
– Element framing type 
– Code-dependent factors 
– Live load reduction factors 
– Effective length factors, K, for major 

and minor direction bending 
– C

m
 factors for major and minor bending 

– 
s
 factors for major and minor 

directions 

 Summary design data 
– Geometric data and graphical 

representation 
– Material properties 
– Minimum design moments 
– Moment factors 
– Longitudinal reinforcing areas 
– Design shear forces 
– Shear reinforcing areas 

 Overwrites 
– Element section ID 
– Element framing type 
– Code-dependent factors 
– Live load reduction factors 
– Effective length factors, K, for major and 

minor direction bending 
– C

m
 factors for major and minor bending 

– 
s
 factors for major and minor directions 

 Summary design data 
– Geometric data and graphical 

representation 
– Material properties 
– Design moments and shear forces 
– Minimum design moments 
– Top and bottom reinforcing areas 
– Shear capacities of concrete and steel 
– Shear reinforcing area 
– Torsion reinforcing area 
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Table 4-1 Member Specific Data for Columns and Beams 
– Shear capacities of steel and concrete 
– Torsion reinforcing 
– Interaction diagram, with the axial 

force and biaxial moment showing the 
state of stress in the column 

 Detailed calculations for flexural details, 
shear details, joint shear, and beam/ 
column capacity ratios 

 

The load combination is reported by its name, while station data is reported by 
its location as measured from the I-end of the column. The number of line 
items reported is equal to the number of design combinations multiplied by the 
number of stations. One line item will be highlighted when the form first dis-
plays. This line item will have the largest required longitudinal reinforcing, 
unless any design overstress or error occurs for any of the items. In that case, 
the last item among the overstressed items or items with errors will be high-
lighted. In essence, the program highlights the critical design item. 

If a column has been selected and the column has been specified to be checked 
by the program, the form includes the same information as that displayed for a 
designed column, except that the data for a checked column includes the ca-
pacity ratio rather than the total longitudinal reinforcing area. Similar to the 
design data, the line item with the largest capacity ratio is highlighted when the 
form first displays, unless an item has an error or overstress, in which case, that 
item will be highlighted. In essence, the program highlights the critical check 
item. 

The program can be used to check and to design rebar in a column member. 
When the users specifies that the program is to check the rebar in the column, 
the program checks the rebar as it is specified. When the user specifies that the 
program design the rebar configuration, the program starts with the data speci-
fied for rebar and then increases or decreases the rebar in proportion to the 
relative areas of rebar at the different locations of rebar in the column.  

4.4.1 Interactive Concrete Frame Design 
The interactive concrete frame design and review is a powerful mode that al-
lows the user to review the design results for any concrete frame design, to re-
vise the design assumptions interactively, and to review the revised results 
immediately.  
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Before entering the interactive concrete frame design mode, the design results 
must be available for at least one member. That means the design must have 
been run for all the members or for only selected members. If the initial design 
is not been performed yet, run a design by clicking the Design menu > Con-
crete Frame Design > Start Design/Check of Structure command in 
SAP2000/ETABS and Advanced > Frame Design > Concrete > Start De-
sign/Check of Structure command in CSiBridge.  

There are three ways to initiate the interactive concrete frame design mode:  

 Click the Design menu > Concrete Frame Design > Start Design/Check 
of Structures command in SAP2000/ETABS and Advanced > Frame 
Design > Concrete > Start Design/Check of Structure command in 
CSiBridge to run a design.  

 Click the Design menu > Concrete Frame Design > Display Design Info 
command in SAP2000/ETABS and the Advanced > Frame Design > 
Concrete > Display Design Information command in CSiBridge to ac-
cess the Display Design Results form and select a type of result.  

 Click the Design menu > Concrete Frame Design > Interactive Con-
crete Frame Design command in SAP2000/ETABS and the Advanced > 
Frame Design > Concrete > Interactive Concrete Frame Design com-
mand in CSiBridge.  

After using any of the three commands, right click on a frame member to enter 
the interactive Concrete Frame Design Mode and access the Concrete Column 
Design Information form if a column member was right clicked or the Con-
crete Beam Design Information form if a beam member was right clicked. 
These forms have Overwrites buttons that accesses the Concrete Frame De-
sign Overwrites form. The form can be used to change the design sections, 
element type, live load reduction factor for reducible live load, and many other 
design factors. See Appendix D for a detailed description of the overwrite 
items. When changes to the design parameters are made using the Overwrites 
form, the Concrete Beam or Column Design Information forms update imme-
diately to reflect the changes. Then other buttons on the Concrete Beam or 
Column Design Information forms can be used to display additional forms 
showing the details of the updated design. See the Member Specific Informa-
tion section of this chapter for more information.  
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In this way, the overwrites can be changed any number of times to produce a 
satisfactory design. After an acceptable design has been produced by changing 
this section or other design parameters, click the OK button on the Concrete 
Beam or Column Design Information forms to permanently change the design 
sections and other overwrites for that member. However, if the Cancel button 
is used, all changes made to the design parameters using the Concrete Frame 
Design Overwrites form are temporary and do not affect the design.   

4.5 Error Messages and Warnings 
In many places of concrete frame design output, error messages and warnings 
are displayed. The messages are numbered. A complete list of error messages 
and warnings used in Concrete Frame Design for all the design codes is pro-
vided in Appendix E. However, all of the messages are not applicable to CSA 
A23.3-04 code. 



 

APPENDICES  





 

 A - 1 

Appendix A 

Second Order P-Delta Effects 

Typically, design codes require that second order P-delta effects be considered 
when designing concrete frames. They are the global lateral translation of the 
frame and the local deformation of members within the frame.  

Consider the frame object shown in Figure A-1, which is extracted from a story 
level of a larger structure. The overall global translation of this frame object is 
indicated by . The local deformation of the member is shown as . The total 
second order P-delta effects on this frame object are those caused by both  
and . 

The program has an option to consider P-delta effects in the analysis. When 
P-delta effects are considered in the analysis, the program does a good job of 
capturing the effect due to the  deformation shown in Figure A-1, but it does 
not typically capture the effect of the  deformation (unless, in the model, the 
frame object is broken into multiple elements over its length).   



Design Manual Concrete Frame CSA A23.3-04 

 

A - 2 Appendix A 

 
Figure A-1 The Total Second Order P-Delta Effects on a  

Frame Element Caused by Both  and  

Consideration of the second order P-delta effects are generally achieved by 
computing the flexural design capacity using a formula similar to that shown in 
the following equation.  

MCAP  =  aMnt + bMlt      where, 

MCAP   = Flexural design capacity required 

Mnt   = Required flexural capacity of the member assuming there is no 
joint translation of the frame (i.e., associated with the  
deformation in Figure A-1) 

Mlt = Required flexural capacity of the member as a result of lateral 
translation of the frame only (i.e., associated with the  
deformation in Figure A-1) 

a = Unitless factor multiplying Mnt 

b = Unitless factor multiplying Mlt (assumed equal to 1 by the 
program; see below) 

 When the program performs concrete frame design, it assumes that the factor  
b is equal to 1 and calculates the factor a. That b = 1 assumes that P-delta ef-
fects have been considered in the analysis, as previously described. Thus, in 
general, when performing concrete frame design in this program, consider 
P-delta effects in the analysis before running the program.   
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Appendix B  
Member Unsupported Lengths and  

Computation of K-Factors   

The column unsupported lengths are required to account for column slender-
ness effects. The program automatically determines the unsupported length ra-
tios, which are specified as a fraction of the frame object length. Those ratios 
times the frame object length gives the unbraced lengths for the members. 
Those ratios can also be overwritten by the user on a member-by-member ba-
sis, if desired, using the overwrite option.  

There are two unsupported lengths to consider. They are L33 and L22, as shown 
in Figure B-1. These are the lengths between support points of the member in 
the corresponding directions. The length L33 corresponds to instability about the 
3-3 axis (major axis), and L22 corresponds to instability about the 2-2 axis (mi-
nor axis).  



Concrete Frame Design CSA A23.3-04 

B - 2 Member Unsupported Lengths and Computation of K-Factors 

 
Figure B-1 Axis of bending and unsupported length 

 

In determining the values for L22 and L33 of the members, the program recog-
nizes various aspects of the structure that have an effect on these lengths, such 
as member connectivity, diaphragm constraints, and support points. The pro-
gram automatically locates the member support points and evaluates the corre-
sponding unsupported length.  

It is possible for the unsupported length of a frame object to be evaluated by 
the program as greater than the corresponding member length. For example, 
assume a column has a beam framing into it in one direction, but not the other, 
at a floor level. In that case, the column is assumed to be supported in one di-
rection only at that story level, and its unsupported length in the other direction 
will exceed the story height.  
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Appendix C 

Concrete Frame Design Preferences   

The concrete frame design preferences are general assignments that are applied 
to all of the concrete frame members. The design preferences should be re-
viewed and any changes from the default values made before performing a de-
sign. The following table lists the design preferences that are specific to using 
CSA A23.3-04; the preferences that are generic to all codes are not included in 
this table. 

Table C-1 Preferences 

Item 
Possible 
Values 

Default 
Value 

Description 

Time History  
Design 

Envelopes, 
Step-by-Step

Envelopes 

Toggle for design load combinations 
that include a time history designed for 
the envelope of the time history, or 
designed step-by-step for the entire 
time history. If a single design load 
combination has more than one time 
history case in it, that design load 
combination is designed for the enve-
lopes of the time histories, regardless 
of what is specified here.  
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Item 
Possible 
Values 

Default 
Value 

Description 

Number  
Interaction 

Curves 

Multiple of 4 
 4 

24 

Number of equally spaced interaction 
curves used to create a full 360 deg 
interaction surface (this item should be 
a multiple of four). We recommend 24 
for this item.   

Number 
Any odd value 

 5 
11 

Number of points used for defining a 
single curve in a concrete frame; 
should be odd   

Consider  
Minimum  

Eccentricity 
No, Yes Yes 

Toggle to consider if minimum eccen-
tricity is considered in design. 

Phi  
(Steel) 

> 0 0.85 
Strength reduction factor for rebar   

Phi  
(Concrete) 

> 0 0.6 
The strength reduction factor for con-
crete   

Pattern Live  
Load Factor  0 0.75 

The scale factor for performing pattern 
loading for live loads 

Utilization  
Factor Limit 

> 0 0.95 
Stress ratios that are less than or equal 
to this value are considered accept-
able 



 

 D - 1 

 

Appendix D 
Concrete Frame Overwrites   

The concrete frame design overwrites are basic assignments that apply only to 
those elements to which they are assigned. Table D-1 lists concrete frame de-
sign overwrites for CSA A23.3-04. Default values are provided for all over-
write items. Thus, it is not necessary to specify or change any of the 
overwrites. However, at least review the default values to ensure they are ac-
ceptable. When changes are made to overwrite items, the program applies the 
changes only to the elements to which they are specifically assigned.  

Table D-1 Overwrites 

Item 
Possible 
Values 

Default 
Value 

Description 

Current  
Design  
Section 

Any defined 
concrete  
section 

Analysis 
section 

The design section for the selected 
frame objects. When this overwrite is 
applied, any previous auto select sec-
tion assigned to the frame object is 
removed.   

Element  
Type 

Ductile  
Moderately 

Ductile,  
Conventional 

From  
Reference 

Frame type per moment frame defini-
tion given in CSA 2.2. The program 
default is Ductile, which the user can 
overwrites if needed.   

Live Load  0 Calculated The reduced live load factor. A reduci-
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Item 
Possible 
Values 

Default 
Value 

Description 

Reduction 
Factor 

ble live load is multiplied by this factor 
to obtain the reduced live load for the 
frame object. Specifying 0 means the 
value is program determined.   

Unbraced 
Length Ratio 

(Major) 
 0 Calculated 

Unbraced length factor for buckling 
about the frame object major axis. This 
item is specified as a fraction of the 
frame object length. Multiplying this 
factor times the frame object length 
gives the unbraced length for the ob-
ject. Specifying 0 means the value is 
program determined.   

Unbraced 
Length Ratio 

(Minor) 
 0 Calculated 

Unbraced length factor for buckling 
about the frame object minor axis. Mul-
tiplying this factor times the frame ob-
ject length gives the unbraced length 
for the object. Specifying 0 means the 
value is program determined. This 
factor is also used in determining the 
length for lateral-torsional buckling.   

Effective 
Length Factor 

(K Major) 
> 0 Calculated 

See CSA, 10.15.1. Effective length 
factor for buckling about the frame ob-
ject major axis. This item is specified as 
a fraction of the frame object length.   

Effective 
Length Factor 

(K Minor) 
> 0 Calculated 

See CSA, 10.15.1. Effective length 
factor for buckling about the frame ob-
ject minor axis. This item is specified as 
a fraction of the frame object length.   

Moment  
Coefficient  
(Cm Major) 

> 0 Calculated 

See CSA 10.15.3.2. Factor relating 
actual moment diagram to an equiva-
lent uniform moment diagram about the 
frame object major axis. 

Moment  
Coefficient  
(Cm Minor) 

> 0 Calculated 

See CSA 10.15.3.2. Factor relating 
actual moment diagram to an equiva-
lent uniform moment diagram about the 
frame object minor axis. 

NonSway 
Moment  
Factor  

(Db major) 

> 0 Calculated 

See CSA 10.15.3.1. The magnified 
non-sway moment factor amplified for 
the effects of member curvature about 
the frame object major axis. 
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Item 
Possible 
Values 

Default 
Value 

Description 

NonSway 
Moment  
Factor  

(Db minor) 

> 0 Calculated 

See CSA 10.15.3.1. The magnified 
non-sway moment factor amplified for 
the effects of member curvature about 
the frame object minor axis. 

Sway Moment 
Factor  

(Ds major) 
1 

From  
Reference 

See CSA 10.16.3.1. The magnified 
sway moment factor shall be taken as 
the column end moments calculated 
using a second-order analysis about 
the frame object major axis. 

Sway Moment 
Factor  

(Ds minor) 
1 

From  
Reference 

See CSA 10.16.3.1. The magnified 
sway moment factor shall be taken as 
the column end moments calculated 
using a second-order analysis about 
the frame object minor axis. 
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Appendix E 

Error Messages and Warnings   

Table E-1 provides a complete list of Concrete Errors messages and Warnings.  

Table E-1 Error Messages 

Error 
Number 

Description 

1 Beam concrete compression failure   

2 Reinforcing required exceeds maximum allowed   

3 Shear stress exceeds maximum allowed   

4 Column design moments cannot be calculated   

5 Column factored axial load exceeds Euler Force   

6 Required column concrete area exceeds maximum   

7 Flexural capacity could not be calculated for shear design   

8 Concrete column supports non-concrete beam/column   
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Error 
Number 

Description 

9 115k L r   , 2 0zeta_  , 1 0eta    (GB50010 7.3.10)   

10 Column is overstressed for P-M-M   

11 Axial compressive capacity for concrete exceeded (TBM 6.4.2)  

12 Beam frames into column eccentrically (11.6.3)   

13 Torsion exceeds maximum allowed   

14 Reinforcing provided is below minimum required   

15 Reinforcing provided exceeds maximum allowed   

16 Tension reinforcing provided is below minimum required   

17 30k L r    (GB 7.3.10)   

21 
The column is not ductile. Beam/column capacity ratio is not 
needed.   

22 
The load is not seismic. Beam/column capacity ratio is not 
needed.   

23 
There is no beam on top of column. Beam/column capacity ratio 
is not needed.   

24 
At least one beam on top of column is not of concrete. 
Beam/column capacity ratio is not calculated.   

25 
The column on top is not of concrete. Beam/column capacity ratio 
is not calculated.   

26 
The station is not at the top of the column. Beam/column capacity 
ratio is not needed.   

27 The column is not ductile. Joint shear ratio is not needed.   
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Error 
Number 

Description 

28 The load is not seismic. Joint shear ratio is not needed.   

29 
There is no beam on top of column. Joint shear ratio is not 
needed.   

30 
At least one beam on top of column is not of concrete. Joint shear 
ratio is not calculated.   

31 
The column on top is not of concrete. Joint shear ratio is not 
needed.   

32 
The station is not at the top of the column. Joint shear ratio is not 
needed.   

33 Beam/column capacity ratio exceeds limit.   

34 Joint shear ratio exceeds limit.   

35 Capacity ratio exceeds limit.   

36 
All beam s around the joint have not been designed. 
Beam/column capacity ratio is not calculated.   

37 
At least one beam around the joint have failed. Beam/column 
capacity ratio is not calculated.   

38 
The column above the joint have not been designed. 
Beam/column capacity ratio is not calculated.   

39 
The column above the joint have failed. Beam/column capacity 
ratio is not calculated.   

40 
All beams around the joint have not been designed. Joint shear 
ratio is not calculated.   

41 
At least one beam around the joint have failed. Joint shear ratio is 
not calculated.   

42 The column above the joint has not been designed. Joint shear 
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Error 
Number 

Description 

ratio is not calculated.   

43 
The column above the joint has failed. Joint shear ratio is not 
calculated.   

45 
Shear stress due to shear force and torsion together exceeds 
maximum allowed.   
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